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Preface

This document is a guide to the Element Manager Java-based graphical user interface (GUI) that runs
on your switch. This document explains how to use Element Manager and provides the steps that you
need to perform to configure your switch with the GUI.

Intended Audience

The intended audience is the administrator responsible for installing, configuring, and managing switch
equipment. This administrator should have experience administering similar networking or storage
equipment.

Typographical Conventions

The following typographic conventions are used in this guide to provide visual clues as to the purpose
or application of specific text.

*  Bold text indicates a command or keyword, or text that appears in your display.
e [talics indicate variables that you replace with an actual value.

*  Square brackets ([,]) indicate an optional argument that you choose to include or exclude when you
enter a command.

*  Pipe character (]) indicates an “or” choice. For example, “a | b” indicates “a or b.”

*  Ellipses (...) indicate truncated text. You will see these in long examples depicting terminal output
that is too long to be shown in its entirety.

pe.

NOTE: Indicates an important point or aspect that you need to consider before continuing.
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Contact Information

Table 2-1: Customer Contact Information

For the name of your nearest authorized
HP reseller

In the United States, refer to the HP US service locator
webpage.
In other locations, refer to the HP website.

For HP technical support

In the United States and Canada, call 1-800-HP-INVENT
(1-800-474-6836). This service is available 24 hours a day,
7 days a week. For continuous quality improvement, calls
may be recorded or monitored.

Outside the United States and Canada, refer to
www.hp.com.



http://www.hp.com/service_locator
http://www.hp.com
www.hp.com

About Element Manager

The following sections appear in this chapter:

*  “Introduction” on page 1

*  “Anatomy of Element Manager” on page 1
e “Installing Element Manager” on page 4

*  “Launching Element Manager” on page 4

Introduction

With Element Manager (EM), you can manage individual switches from an easy-to-use GUI. To run
EM, you must:

1. Install the EM software on a host or workstation.
2. Configure your switch(es) to support EM.

3. Launch EM on your host or workstation.

Anatomy of Element Manager

The primary display of EM provides nine pulldown menus, nine feature buttons, and various selectable
display elements that vary by switch platform. Table 1-1 and Table 1-2 list and describe the menus and
buttons. Selectable display elements vary by hardware platform.

When you select a display element (such as switch ports), a yellow border appears around the element:
1.  Double-click any selectable element to open a related configuration window:
2. Right-click these elements to view element-specific right-click menus.

3. Use these menus and windows to view element details or change the configuration.



pe.

NOTE: You can hold the Ctrl button and select multiple elements of the same type to configure them
as a group [for example, multiple InfiniBand (IB) ports]. After you select multiple like elements, right-
click one of the elements to display a right-click menu for options that you can apply.

Table 1-1 lists and describes the pulldown menus on the EM display.

Table 1-1: Element Manager Pulldown Menus

Menu Description

File Use the menu items in the File menu to:

*  Load a switch in the EM display.

*  Configure EM performance preferences.
*  Refresh the EM display.

»  Telnet to the open switch to configure the switch with the CLI. (For CLI details,
refer to the HP 24-Port 4x Fabric Copper Switch Command Line Interface
Reference Guide.

Edit Use the Edit menu to view port properties or card properties.

Maintenance |Use the menu items in the Maintenance menu to:
*  View switch details.

*  View and configure basic services.

*  View and configure the boot configuration.

*  Back-up the running configuration.

»  Import and export files.

*  Reboot the switch.

»  Track diagnostic tests.

Health Use the menu items in the Health menu to monitor switch status and events.

Report Use the menu items in the Report menu to graph switch statistics.

InfiniBand Use the menu items in the InfiniBand menu to configure IB-specific switch
features, including the Device Manager and Subnet Manager (SM).

Ethernet Use the menu items in the Ethernet menu to configure Ethernet-specific switch
features.

Fibre Channel |Use the menu items in the FibreChannel menu to configure FC-specific switch
features.

Help Use the menu items in the Help menu to launch on-line help and locate additional
help resources.

Table 1-2 lists and describes the feature buttons on the EM display.

Table 1-2: Element Manager Feature Buttons

Button Description
Open Click the Open button to load a different switch in the EM display.
Refresh Click the Refresh button to poll the switch and update the EM display.




Table 1-2: Element Manager Feature Buttons (Continued)

Button

Description

Telnet

Click the Telnet button to launch a telnet session to the switch.

B : M

Click the Help button to launch EM on-line help.

Properties

re

After selecting an element (or multiple elements of the same type), click
the Properties button to view the properties of the element(s).

Graph

134

After selecting an element (or multiple elements of the same type), click
the Graph button to select element statistics you want to graph.

Topology

o™

Click the Topology button to view the switch and neighboring devices.

Subnet Management

5]

Click the Subnet Management button to open the Subnet Management
window and configure partitions, multicast groups, and other Subnet
Manager-related features.

Storage Manager

Click the Storage Manager button to open the Storage Manager window
and configure initiators, targets, and LUNS.

Common GUI Buttons

Many windows that you can open in EM display a combination of frequently appearing buttons.
Table 1-3 lists and describes these common buttons.

Table 1-3: Common Buttons

Button Description

Apply Applies any changes that you made in the window to the switch.
Refresh Updates the window with the latest information from the switch.
Close Closes the window.

Help Launches context-sensitive on-line help.

Status Indicators

The EM display uses specific colors to communicate the status of switch elements.

Table 1-4: Status Indicator Colors

Color Indication

gray Element is not active (for example, an IB port that does not connect to a cable).
red An administrator has taken the element offline or the element experiences an error.
green Element functions successfully.

transparent Element is unmanaged.




Installing Element Manager

EM runs on Linux and Windows platforms. Follow installation instructions for the appropriate
platform.

System Requirements (All Platforms)

To install EM, your system must meet the following requirements:
* 64 MB of available RAM

* 75 MB of available hard disk space and 50 MB of additional available hard disk space during
installation

e 300 MHz processor
*  800x600 screen resolution with 16-bit color depth

Performing the Installation

To install EM:
1. Log in to the host system.
2. Download the software and documentation from the HP Web site at http:\\support.hp.com.
3. Install the software:
a.  Unzip the tar file containing the software using gunzip.
b. Extract the software into a local directory using tar.

c. Install the software. Refer to the HP Dual-port 4x Fabric Adapter User Guide provided with
the software for instructions.

Launching Element Manager

When you launch EM, the EM interface requests the IP address (or DNS name) of the switch that you
want to manage. To successfully connect to the switch that you want to manage, you must first
configure the switch to permit EM access. If EM fails to connect to the switch, verify that the switch
meets the prerequisites for EM.

Preparing your Switch

Factory defaults permit your switch to connect to EM. The following settings must apply to your switch
to open it in EM:

e HTTP server enabled
e telnet server enabled

*  SNMP server configured

To view your switch settings:
1. Log in to your switch.
2. View the desired switch settings:
*  Enter the enable command to enter Privileged Exec mode.
*  Enter the configure terminal command to enter Global Configuration mode.
*  Enter the ip http server command to enable the HTTP server.
*  Enter the telnet enable command to enable telnet services.

*  Enter the snmp-server command with the following to configure an SNMP server:



*  the IP address of the server that you want to configure

*  (optional) the recv-event-traps keyword

For more details, refer to the HP 24-Port 4x Fabric Copper Switch Command Line Interface Reference
Guide.






Chassis Display Tasks

The following sections appear in this chapter:

Introduction

“Introduction” on page 7

“Viewing Port Properties” on page 8

“Viewing Serial Management Port Properties” on page 10
“Viewing Ethernet Management Port Properties” on page 10
“Viewing InfiniBand Management Port Properties” on page 11
“Configuring Ports” on page 11

“Rebooting the Switch” on page 12

When you launch EM and open a switch, a graphical display of that switch appears. Colors in the
display indicate the status of various components of the switch. Various right- and left-click options let
you configure the components that you see in the display.



Viewing Port Properties

To view port properties:

1.

Right-click the port in the chassis display whose properties you want to view. A right-click menu

appears.

Select Properties... from the right-click menu. A window opens and displays the type and number
of the port in the title bar. The contents of the window vary by port type. Table 2-1 lists and
describes the fields in the Properties window of an Ethernet port.

Table 2-1: Ethernet Port Properties Window Fields

Field Description

Port Type Displays the port number in slot#/port# format.

Port Name Provides a port name that you can edit and apply to the port.
Enable/Disable Port Provides the up and down radio buttons so you can

configure the administrative status of the port.

Current Port Status

Indicates whether or not the port is ready for use.

Auto Negotiation Supported

Displays true if the port supports auto-negotiation.

Enable Auto Negotiation
(checkbox)

Enables or disables auto-negotiation on the port.

Set Port Speed

Provides radio buttons to let you configure the speed of the
port.

Current Port Speed

Displays the speed of the port.

Set Duplex

Provides radio buttons to let you configure the duplex
setting of the port.

Current Duplex

Indicates whether the port runs in full duplex mode or half
duplex mode.

Enable Link Up/Down Trap

Provides enabled and disabled radio buttons to configure
whether or not the port sends a trap when links go up or
down.

MTU Displays the maximum transmission unit (MTU) of the
port, in bytes.

MAC Address Displays the media access control (MAC) address of the
port.

Last Changed On Displays the time and date of the last time that a user
configured the port.

Action Lets you flush the ARP table when you click the Apply
button.

Result Displays the result of the action that you perform from the

Action field.

Table 2-2 lists and describes the fields in the Properties window of a Fibre Channel (FC) port.

Table 2-2: Fibre Channel Port Properties Window Fields

Field Description
Port Type Displays the port number in slot#/port# format.
Port Name Provides a port name that you can edit and apply to the port.




Table 2-2: Fibre Channel Port Properties Window Fields

Field

Description

Enable/Disable Port

Provides the up and down radio buttons so you can
configure the administrative status of the port.

Current Port Status

Indicates whether or not the port is ready for use.

Auto Negotiation Supported

Displays true if the port supports auto-negotiation.

Enable Auto Negotiation
(checkbox)

Enables or disables auto-negotiation on the port.

Set Port Speed Provides radio buttons to let you configure the speed of the
port.
Current Port Speed Displays the speed of the port.

Enable Link Up/Down Trap

Provides enabled and disabled radio buttons to configure
whether or not the port sends a trap when links go up or
down.

MTU Displays the MTU of the port, in bytes.

WWNN Worldwide node name of the HCA of the port.

WWPN Worldwide port name of the port.

Last Changed On Displays the time and date of the last time that a user
configured the port.

Action Lets you flush the ARP table when you click the Apply
button.

Result Displays the result of the action that you perform from the

Action field.

Table 2-3 lists and describes the fields in the Properties window of an IB port.

Table 2-3: InfiniBand Port Properties Window Fields

Field Description

Port Type Displays the port number in slot#/port# format.

Port Name Provides a port name that you can edit and apply to the port.
Enable/Disable Port Provides the up and down radio buttons so you can

configure the administrative status of the port.

Current Port Status

Indicates whether or not the port is ready for use.

Auto Negotiation Supported

Displays true if the port supports auto-negotiation.

Enable Auto Negotiation
(checkbox)

Enables or disables auto-negotiation on the port.

Set Port Speed

Provides radio buttons to let you configure the speed of the
port.

Current Port Speed

Displays the speed of the port.

Enable Link Up/Down Trap

Provides enabled and disabled radio buttons to configure
whether or not the port sends a trap when links go up or
down.

MTU

Displays the MTU of the port, in bytes.

Last Changed On

Displays the time and date of the last time that a user
configured the port.
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Viewing Serial Management Port Properties

To view Serial Management port properties:

1.
2.

Click the Edit menu and select Management Ports. The Management Ports window opens.
Click the Serial Port tab. Table 2-4 lists and describes the fields on this tab.

Table 2-4: Serial Management Port Window Fields

Field Description

Baud Rate Baud rate setting to which you must set your serial connection.
Data Bits Data bit setting to which you must set your serial connection.
Stop Bits Stop bit setting to which you must set your serial connection.
Parity Parity field setting to which you must set your serial connection.

Establishing a Serial Connection

To create a serial connection to your switch:

1.

Connect the straight-through M/F serial cable (provided with your switch) to the Serial
Management port, then connect the cable to your terminal, workstation, or terminal server.

Launch a terminal session (on a workstation, use a terminal emulation application such as
HyperTerminal) and configure your terminal parameters to match the parameters in Table 2-4.

Press the Enter key until the Login prompt appears.

Viewing Ethernet Management Port Properties

To view Ethernet Management port properties:

1.
2.

Click the Edit menu and select Management Ports. The Management Ports window opens.
Click the Ethernet Port tab. Table 2-5 lists and describes the fields on this tab.

Table 2-5: Ethernet Management Port Window Fields

Field Description

MAC Address MAC address of the Ethernet Management port (which serves

as the MAC address of the switch).

Enable Auto Negotiation Displays true if the Ethernet Management port dynamically
determines the connection speed of the device to which it
connects over via Ethernet cable; otherwise displays false.

Administrative Port Status Displays the administrative status that you configure via the
CLI with the shutdown and no shutdown commands.

Current Port Status Displays up if the port runs successfully; displays down if the
port cannot transmit and receive traffic for any reason.

IP Address IP address of the Ethernet Management port.

Network Mask Subnet mask of the Ethernet Management port.

Address Option Displays the address option that you configure with the

addr-option CLI command.
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Viewing InfiniBand Management Port Properties

To view IB Management port properties:

1.
2.

Click the Edit menu and select Management Ports. The Management Ports window opens.
Click the Ethernet Port tab. Table 2-6 lists and describes the fields on this tab.

Table 2-6: InfiniBand Management Port Window Fields

Field Description

Administrative Port Status Displays the administrative status that you configure via the
CLI with the shutdown and no shutdown commands.

Current Port Status Displays up if the port runs successfully; displays down if the
port cannot transmit and receive traffic for any reason.

IP Address IP address of the IB Management port.

Network Mask Subnet mask of the IB Management port.

Gateway field IP address of the gateway that the IB Management port uses.

Address Option Displays the address option that you configure with the

addr-option CLI command.

Configuring Ports

EM provides different configuration options for each type of port. The options available to each port
will appear in the Port Properties window.

NOTE: To configure multiple ports at once, hold the Ctrl key and select multiple ports of the same
type, then right-click one of the ports that you selected to view right-click menu options.

Configuring a Port Name

To configure the administrative name of a port:

1.

2.

Double-click the port that you want to configure. A window opens that identifies the type of the
port and the port number (in slot#/port# format).

In the Port Name field of the window, enter a name for the port, then click the Apply button.

Click the Close button to close the window.

Enabling or Disabling a Port

To enable or disable a port:

1.

Double-click the port that you want to configure. A window opens that identifies the type of the
port and the port number (in slot#/port# format).

In the Enable/Disable Port field of the window, click the up (enable) or down (disable) radio
button, then click the Apply button.

Click the Close button to close the Port Properties window.

NOTE: As a shortcut, right-click the port and select Enable or Disable.
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Configuring Auto-Negotiation on a Port

To enable or disable auto-negotiation on a port:

1. Double-click the port that you want to configure. A window opens that identifies the type of the
port and the port number (in slot#/port# format).

2. Inthe Auto Negotiation Supported ficld of the window, check (enable) or uncheck (disable) the
Enable Auto-Negotiation checkbox, then click the Apply button.

3. Click the Close button to close the window.

Configuring Port Speed

To configure the speed of a port:

1. Double-click the port that you want to configure. A window opens that identifies the type of the
port and the port number (in slot#/port# format).

2. Inthe Auto Negotiation field, uncheck the Enable checkbox (if necessary).

In the Set Port Speed field of the window, click a radio button to select a speed, then click the
Apply button.

4. Click the Close button to close the window.

Rebooting the Switch

To reboot the chassis:

1. Right-click the switch in the chassis display (avoid selectable elements such as ports and cards) and
click Reboot. A window opens and prompts you to save configuration changes.

2. Click Yes to save configuration changes or No to discard the changes. A window opens to verify
that you want to reboot.

3. Click OK to reboot, otherwise click Cancel.
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File Menu Tasks

The following sections appear in this chapter:

Introduction

“Introduction” on page 13

“Opening a Switch with Element Manager” on page 13
“Configuring Polling Interval” on page 14

“Configuring SNMP Preferences” on page 14
“Configuring Miscellaneous Trap Preferences” on page 15
“Refreshing the Element Manager Display” on page 15
“Launching a Telnet Session” on page 16

“Closing Element Manager” on page 16

The File menu in the EM GUI provides basic GUI functions and configuration options. Some feature
buttons provide the same functions. Where the menu and the buttons overlap, the tasks in this chapter
describe both options.

Opening a Switch with Element Manager

After you launch EM, you can change the switch that you view and configure with the GUI. To
configure a switch other than the one that you opened when you launched EM:

1.
2.

Click the File menu and select Open. The Open Device window opens.

Enter the IP address or DNS name (if applicable) of the switch that you want to open in the Device
Name or IP Address field.

Enter the SNMP community to which the switch belongs in the SNMP Community field.
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4. Click the Open button. The switch loads in the EM GUI.

Using the Open Button

To open a switch with the Open button:
1. Click the Open button (&). The Open Device window opens.

2. Enter the IP address or DNS name (if applicable) of the switch that you want to open in the Device
Name or IP Address field.

Enter the SNMP community to which the switch belongs in the SNMP Community field.
4. Click the Open button. The switch loads in the EM GUI.

Configuring Polling Interval

To configure the frequency with which EM polls the switch for updates:
1. Click the File menu and select Preferences. The Preferences window opens.

2. Click the Polling tab.

3. Enter an integer value in the Status Interval field to configure the interval, in seconds, at which
EM polls the switch.

4. Enter an integer value in the Hotswap Detect every field to configure the number of status
intervals that pass before EM detects removed or replaced hot-swappable hardware components.

5. Check the Enable checkbox, then click the OK button.

Disabling Polling

When you disable polling, the EM only refreshes when you manually refresh the display (refer to
“Refreshing the Element Manager Display” on page 15). To disable polling:

1. Click the File menu and select Preferences. The Preferences window opens.

2. Click the Polling tab.
3.  Uncheck the Enable checkbox, then click the OK button.

Configuring SNMP Preferences

The SNMP preferences that you can configure depend on the application that controls port 162 on the
host that runs EM. switches send all SNMP traps to port 162. If you run an application other than EM
that manages port 162, you must manually register your host in each switch that you open with EM to
send switch traps to your application. To manually register your host, refer to “Configuring Your Host
as a Trap Receiver” on page 45.

If EM controls port 162 to receive SNMP traps from the switch, you can configure host registration and
other options. To configure SNMP preferences:

1. Click the File menu and select Preferences. The Preferences window opens.
2. Click the SNMP tab.

3. Enter an integer value (from 0 to 5) in the Retry Count field to specify the maximum number of
retries.

4. Enter an integer value (from 3 to 30) in the Timeout field to configure the SNMP timeout interval,
in seconds.

5. (Optional) Check the Trace checkbox to begin tracing SNMP traps.
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O
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NOTE: You can view the SNMP traps as you trace them with the Trace Log (refer to “Viewing
Element Manager Trace Log” on page 15).

(Optional) Check the Register for Traps checkbox to configure EM to automatically add your host
to the Trap Receivers table on any switch that you open in the EM GUI. If another application on
your host receives SNMP traps, refer to “Configuring Your Host as a Trap Receiver” on page 45 to
send switch traps to that application.

e

NOTE: When you check the Register for Traps checkbox, EM automatically checks the Listen
for Traps checkbox.

(Optional) Check the Listen for Traps checkbox to receive SNMP traps from the switch.

@)
7/

NOTE: If EM does not let you access this checkbox, uncheck the Register for Traps checkbox.

Click the OK button.

Configuring Miscellaneous Trap Preferences

To configure miscellaneous trap preferences:

1.
2.
3.

6.

Click the File menu and select Preferences.
Click the Misc tab.

Enter an integer value in the Max Traps in Log field to limit the number of traps that appear in the
log.

(Optional) Check the Confirm row deletion checkbox to confirm row deletion.

(Optional) Check the Save communities in configuration files checkbox to save SNMP
communities in the configuration file.

Click the OK button.

Viewing Element Manager Trace Log

To view the EM trace log:

A e

Click the File menu and select Preferences.

Click the SNMP tab.

Check the Trace checkbox to begin tracing SNMP traps.
Click the Misc tab.

Check the Show Element Manager Trace Log checkbox.
Click the OK button. The Trace Log window opens.

Refreshing the Element Manager Display

To refresh the EM display to reflect the most recent status of the switch, perform one of the following
steps:

Click the File menu and select Refresh.
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*  Click the Refresh button (®).

Launching a Telnet Session

To refresh the EM display to reflect the most recent status of the switch, perform one of the following
steps:

e Click the File menu and select Telnet.

e Click the Telnet button ().

Closing Element Manager

To close EM, click the File menu and select Exit.
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Edit Menu Tasks

The following sections appear in this chapter:

*  “Introduction” on page 17

*  “Viewing Properties of One Port” on page 17

e “Viewing Properties of All Ports of the Same Type” on page 19
*  “Configuring Port Properties” on page 20

Introduction

Use the Edit menu to select all ports of the same type and view the properties of those ports. Perform
Edit menu tasks with the EM chassis display. To view and configure the switch from the chassis
display, refer to “Chassis Display Tasks” on page 7.

Viewing Properties of One Port

To view the properties of one port:
1. Click the port whose properties you want to view.

2. Click the Edit menu and click Port Properties. A window opens and displays the properties of the
port.

Table 4-1 lists and describes the fields in the Properties window of an Ethernet port.

Table 4-1: Ethernet Port Properties Window Fields

Field Description

Port Type Displays the port number in slot#/port# format.

Port Name Provides a port name that you can edit and apply to the port.
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Table 4-1: Ethernet Port Properties Window Fields

Field

Description

Enable/Disable Port

Provides the up and down radio buttons so you can
configure the administrative status of the port.

Current Port Status

Indicates whether or not the port is ready for use.

Auto Negotiation Supported

Displays true if the port supports auto-negotiation.

Enable Auto Negotiation
(checkbox)

Enables or disables auto-negotiation on the port.

Set Port Speed Provides radio buttons to let you configure the speed of the
port.

Current Port Speed Displays the speed of the port.

Set Duplex Provides radio buttons to let you configure the duplex

setting of the port.

Current Duplex

Indicates whether the port runs in full duplex mode or half
duplex mode.

Enable Link Up/Down Trap

Provides enabled and disabled radio buttons to configure
whether or not the port sends a trap when links go up or
down.

MTU Displays the maximum transmission unit (MTU) of the
port, in bytes.

MAC Address Displays the media access control (MAC) address of the
port.

Last Changed On Displays the time and date of the last time that a user
configured the port.

Action Lets you flush the ARP table when you click the Apply
button.

Result Displays the result of the action that you perform from the

Action field.

Table 4-2 lists and describes the fields in the Properties window of an FC port.

Table 4-2: Fibre Channel Port Properties Window Fields

Field Description

Port Type Displays the port number in slot#/port# format.

Port Name Provides a port name that you can edit and apply to the port.
Enable/Disable Port Provides the up and down radio buttons so you can

configure the administrative status of the port.

Current Port Status

Indicates whether or not the port is ready for use.

Auto Negotiation Supported

Displays true if the port supports auto-negotiation.

Enable Auto Negotiation
(checkbox)

Enables or disables auto-negotiation on the port.

Set Port Speed

Provides radio buttons to let you configure the speed of the
port.

Current Port Speed

Displays the speed of the port.
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Table 4-2: Fibre Channel Port Properties Window Fields

Field

Description

Enable Link Up/Down Trap

Provides enabled and disabled radio buttons to configure
whether or not the port sends a trap when links go up or
down.

MTU Displays the MTU of the port, in bytes.

WWNN Worldwide node name of the HCA of the port.

WWPN Worldwide port name of the port.

Last Changed On Displays the time and date of the last time that a user
configured the port.

Action Lets you flush the ARP table when you click the Apply
button.

Result Displays the result of the action that you perform from the

Action field.

Table 4-3 lists and describes the fields in the Properties window of an InfiniBand port.

Table 4-3: InfiniBand Port Properties Window Fields

Field Description

Port Type Displays the port number in slot#/port# notation.

Port Name Provides a port name that you can edit and apply to the port.
Enable/Disable Port Provides the up and down radio buttons so you can

configure the administrative status of the port.

Current Port Status

Indicates whether or not the port is ready for use.

Auto Negotiation Supported

Displays true if the port supports auto-negotiation.

Enable Auto Negotiation
(checkbox)

Enables or disables auto-negotiation on the port.

Set Port Speed

Provides radio buttons to let you configure the speed of the
port.

Current Port Speed

Displays the speed of the port.

Enable Link Up/Down Trap

Provides enabled and disabled radio buttons to configure
whether or not the port sends a trap when links go up or
down.

MTU

Displays the MTU of the port, in bytes.

Last Changed On

Displays the time and date of the last time that a user
configured the port.

Viewing Properties of All Ports of the Same Type

To view the properties of all ports of the same type:

1.

Click Edit > Select All, then select the type of port that you want to select. Yellow selection
boundaries appear around all ports of that type.

Click the Edit menu and click Port Properties. A window opens and displays a table of all of the

properties of the selected ports.
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Configuring Port Properties

You can use the Edit menu to configure port properties, or you can use the chassis display directly. To
configure port properties from the chassis display, refer to “Chassis Display Tasks” on page 7.

Configuring Port Name
You can rename ports from a one-port display or a multiple-port display.

One Port

To configure the name of one port:

1. Click the port whose name you want to change.

2. Click the Edit menu and select Port Properties. A window opens and displays port details.
3. Edit the name in the Port Name field, click the Apply button, then click the Close button.

Multiple Ports

To configure the names of multiple ports:
1. Click Edit > Select All, then click the type of the ports whose names you want to configure.

2. Click the Edit menu and select Port Properties. A window opens and displays a tabular layout of
the properties of the ports.

3. Double-click the text in the Port Name column of a port that you want to rename, then edit the
name. Repeat this step for all ports that you want to rename.

4. Click the Apply button, then click the Close button.

Enabling or Disabling a Port
You can enable or disable ports from a one-port display or a multiple-port display.

One Port

To enable or disable one port:

1. Click the port that you want to enable or disable.

2. Click the Edit menu and select Port Properties. A window opens and displays port details.
3. Inthe Enable/Disable Port field, click the up radio button or down radio button.

4. Click the Apply button, then click the Close button.

Multiple Ports

To enable or disable multiple ports:
1. Click Edit > Select All, then click the type of the ports whose names you want to configure.

2. Click the Edit menu and select Port Properties. A window opens and displays a tabular layout of
the properties of the ports.

3. Click the cell in the Enable/Disable Port column of a port that you want to enable or disable, then
select up or down from the pulldown menu that appears.

4. Click the Apply button, then click the Close button.

Enabling or Disabling Auto-Negotiation

You can enable or disable auto-negotiation on ports from a one-port display or a multiple-port display.
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One Port

To enable or disable auto-negotiation on one port:

1. Click the port that you want to enable or disable.

2. Click the Edit menu and select Port Properties. A window opens and displays port details.
3. Check or uncheck the Enable Auto-Negotiation checkbox.

4. Click the Apply button, then click the Close button.

Multiple Ports

To enable or disable auto-negotiation on multiple ports:
1. Click Edit > Select All, then click the type of the ports whose names you want to configure.

2. Click the Edit menu and select Port Properties. A window opens and displays a tabular layout of
the properties of the ports.

3. Click the cell in the Enable Auto-Negotiation column of a port that you want to configure, then
select true or false from the pulldown menu that appears.

4. Click the Apply button, then click the Close button.

Configuring Port Speed

You can configure port speed from a one-port display or a multiple-port display.

pe.

NOTE: You must disable auto-negotiation on a port before you assign a speed to the port.

One Port

To configure port speed for one port:

1. Click the port that you want to enable or disable.

2. Click the Edit menu and select Port Properties. A window opens and displays port details.
3. Click the radio button, in the Set Port Speed field, of the speed that you want to apply.

4. Click the Apply button, then click the Close button.

Multiple Ports

To enable or disable negotation on multiple ports at once:
1. Click Edit > Select All, then click the type of the ports whose names you want to configure.

2. Click the Edit menu and select Port Properties. A window opens and displays a tabular layout of
the properties of the ports.

3. Click the cell in the Set Port Speed column of a port that you want to configure, then select the
speed that you want to apply from the pulldown menu that appears. Repeat this step for all ports
that you want to configure.

4. Click the Apply button, then click the Close button.

Enabling or Disabling Link Up/Down Traps

You can enable or disable link up and link down traps from a one-port display or a multiple-port display.
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One Port

To enable or disable up/down traps for one port:

1.
2.
3.
4

Click the port that you want to configure.

Click the Edit menu and select Port Properties. A window opens and displays port details.
Click the enabled or disabled radio button, in the Enable Link Up/Down Trap field.
Click the Apply button, then click the Close button.

ultiple Ports

To enable or disable up/down traps for multiple ports:

1.
2.

4.

Click Edit > Select All, then click the type of the ports whose names you want to configure.

Click the Edit menu and select Port Properties. A window opens and displays a tabular layout of
the properties of the ports.

Click the cell in the Enable Link Up/Down Trap column of a port that you want to configure, then
the select enabled or disabled from the pulldown menu that appears. Repeat this step for all ports
that you want to configure.

Click the Apply button, then click the Close button.

Executing Port Actions

Some port types can execute specific actions. You can execute actions from a one-port display or a
multiple-port display.

One Port

To execute actions on one port:

1.
2.
3.
4

Click the port that you want to enable or disable.
Click the Edit menu and select Port Properties. A window opens and displays port details.
In the Action field, click the radio button of the action that you want to execute.

Click the Apply button, then click the Close button.

ultiple Ports

To execute actions on multiple ports:

1.
2.

Click Edit > Select All, then click the type of the ports whose names you want to configure.

Click the Edit menu and select Port Properties. A window opens and displays a tabular layout of
the properties of the ports.

Click the cell in the Action column of a port on which you want to execute an action, then select
the action from the pulldown menu that appears. Repeat this step for every port on which you want
to execute an action.

Click the Apply button, then click the Close button.



Maintenance Menu Tasks

The following sections appear in this chapter:

“Introduction” on page 24

“Viewing Basic System Information” on page 24
“Configuring Basic System Information” on page 24
“Configuring Date and Time Properties” on page 25
“Configuring Basic Services” on page 26

“Viewing RADIUS Servers” on page 27

“Enabling HTTP Services” on page 29

“Customizing the Boot Configuration” on page 29
“Backing Up the Running Configuration File” on page 30
“Viewing Files in the File System” on page 30

“Installing Software Images” on page 31

“Importing Configuration Files and Image Files” on page 34
“Exporting Configuration Files and Log Files” on page 35
“Saving a Configuration File” on page 35

“Rebooting Your Switch” on page 36

“Running General Diagnostics” on page 36

“Viewing POST Diagnostics” on page 38

“Viewing FRU Diagnostics” on page 39
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Introduction

The Maintenance menu provides opportunities to monitor your switch and configure fundamental
behavior.

Viewing Basic System Information

Basic system information includes the name of your device, the location of your device, and support
resources. To view basic system information:

1.

Click the Maintenance menu and select System Info. The System Info window opens. Table 5-1
lists and describes the fields in the window.

Table 5-1: System Info Window Fields

Field

Description

Description

Description of the chassis and the image that runs on the chassis.

System Uptime

Amount of time the chassis has run since the last boot.

Last Change Made At

Date and time that a user last changed the running configuration.

Last Config Saved At

Date and time that a user last saved the running configuration as
the startup configuration.

System Name

Configurable name for your switch.

Location

Configurable location of your switch.

Support Contact

Configurable support information for your switch.

Rack Locator UID (select
chassis)

Unique identifier (UID) for the Rack Locator test.

SystemOperMode

Provides the Normal radio button for non-VFrame systems and the
VFrameManaged radio button for systems in a VFrame
environment. For more information, refer to VFrame
documentation.

Configuring Basic System Information

Basic system information includes the name of your device, the location of your device, and support
resources.

Naming Your InfiniBand Switch

To assign a hostname to your device:

1.
2.

Click the Maintenance menu and select System Info. The System Info window opens.

In the System Name field, enter the name that you want to assign to the device, then click the

Apply button.

Defining Device Location

To add a physical device location description to your switch:

1.
2.

Click the Maintenance menu and select System Info. The System Info window opens.

In the Location field, enter the location of your device, then click the Apply button.
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Defining Technical Support Resource

The technical support email address that you define appears in the System frame when you refresh or
restart EM. To define a technical support resource:

1. Click the Maintenance menu and select System Info. The System Info window opens.

2. Inthe Support Contact field, enter the email address of your technical support provider, then click
the Apply button.

Configuring SystemOperMode

Configure SystemOperMode status to alter the behavior of the switch to respond appropriately to a
VFrame environment or a non-VFrame environment. To configure SystemOperMode:

1. Click the Maintenance menu and select System Info. The System Info window opens.
2. In the SystemOperMode ficld, click on of the following radio buttons:

*  Normal-to configure the switch for a non-VFrame environment

*  VFrameManaged-to configure the switch for a VFrame-managed environment

3. Click the Apply button.

Configuring Date and Time Properties

An internal clock runs on your device, but we recommend that you configure your device to access a
network time protocol (NTP) server to synchronize your device with your network.

Configuring Date and Time

To configure the date and time of the internal clock on your device:

1. Click the Maintenance menu and select Time. The Date and Time Properties window opens.
2. In the Date field, enter the date in the MM/DD/YY format.

3. Inthe Time field, enter the time in HH:MM:SS format, then click the Apply button.

4. Click the Apply button in the Date and Time partition.

Assign NTP Servers

To configure your device to use an NTP server to synchronize your switch with the network:
1. Click the Maintenance menu and select Time. The Date and Time Properties window opens.
2. Inthe NTP Server 1 field, enter the IP address of the NTP server that you want your switch to use.

3. (Optional) In the NTP Server 2 ficld, enter the IP address of the NTP server that you want your
switch to use in the event that your switch cannot access the primary NTP server.

4. (Optional) In the NTP Server 3 field, enter the IP address of the NTP server that you want your
switch to use in the event that your switch cannot access the primary or secondary NTP servers.

5. Click the Apply button in the NTP Servers partition.

pe.

NOTE: When your device cannot access a NTP server, it defaults to the on-board clock.
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Configuring Basic Services

Configure basic services to facilitate remote access to your device.

Assigning a DNS Server

To assign a DNS server to your device:

1. Click the Maintenance menu and select Services. The Services window opens.

2. Click the DNS tab.

3. Inthe Server 1 field, enter the IP address of the primary DNS server that you want to use.
4

(Optional) In the Server 2 field, enter the IP address of the DNS server that you want to use if your
device cannot access the primary DNS server.

5. Inthe Domain field, enter the domain to which you want your switch to belong, then click the
Apply button.

Enabling or Disabling the FTP Access

To enable FTP transfers to and from your device:
1. Click the Maintenance menu and select Services. The Services window opens.
2. Click the FTP tab.

3. Check (to enable) or uncheck (to disable) the Enable FTP Server checkbox, then click the Apply
button.

Enabling or Disabling the Telnet Access

To enable telnet access to your device:
1. Click the Maintenance menu and select Services. The Services window opens.
2. Click the Telnet tab.

3. Check (to enable) or uncheck (to disable) the Enable Telnet Server checkbox, then click the
Apply button.

Assigning a SYSLOG Server

pe.

NOTE: This task assumes that you have already configured the host and connected it to the IB fabric.

To assign a SYSLOG server to store logs from your device:
1. Click the Maintenance menu and select Services. The Services window opens.
2. Click the Syslog tab.

3. Inthe Remote Syslog Server field, enter the IP address of the remote server to accept messages
from your device, then click the Apply button.

Assigning an Authentication Method

To assign an authentication method to your device:
1. Click the Maintenance menu and select Services. The Services window opens.
2. Click the Radius tab.
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In the Authentication Method field, click a radio button to select a method, then click the Apply
button. Table 5-2 lists and describes the radio buttons that you can choose.

Table 5-2: CLI Authentication Methods

Button Description

local Authenticates user logins with the local CLI user database only.

localThenRadius Authenticates user logins with the local CLI user database; upon failure,
authenticates with the RADIUS server.

radiusThenLocal Authenticates user logins with the RADIUS server; upon failure,
authenticates with the local CLI user database.

Viewing RADIUS Servers

To view the RADIUS servers that you have configured your device to use to authenticate CLI and EM
logins:

1.
2.

Click the Maintenance menu and select Services. The Services window opens.
Click the Radius Servers tab. Table 5-3 lists and describes the fields in the Radius Servers table.

Table 5-3: Radius Server Properties Window Fields

Field Description
Address Displays the IP address of the RADIUS server.
UDP Port UDP authentication port of the RADIUS server.

Edit this value and click the Apply button to configure the UDP port of
the RADIUS server. The numbers to the right of the field indicate the
range of integer values that this field supports.

Encryption Key Authentication key that the client and RADIUS server use.

Enter a value and click the Apply button to configure the encryption key
of the RADIUS server. The numbers to the right of the field indicate the
range of integer values that this field supports.

Timeout Amount of time, in seconds, in which the server must authenticate a login
before the login fails.

Edit this value and click the Apply button to configure the timeout value
of the RADIUS server. The numbers to the right of the field indicate the
range of integer values that this field supports.

Max Retries Number of sequential logins that a user may perform before the server
denies access to the username altogether.

Edit this value and click the Apply button to configure the maximum
number of retries that the RADIUS server permits. The numbers to the
right of the field indicate the range of integer values that this field
supports.

Access Requests Number of authentication requests that the server has received from your
device since your device booted.

Access Accepts Number of logins to your device that the server authenticated since your
device booted.

Access Rejects Number of logins to your device that the server denied since your device

booted.
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Table 5-3: Radius Server Properties Window Fields

Field Description
Server Timeout Number of authentications that timed out on the server since your device
booted.

Adding RADIUS Servers

To configure a new RADIUS server on your device:

1.
2.
3.

9

Click the Maintenance menu and select Services. The Services window opens.
Click the Radius Servers tab.

Click the Insert button. The Insert Radius Server window opens.

@)

d
NOTE: Click the Close button at any time to abort this process with no changes to your device.

Configurations apply only after you click the Apply button.

In the Address field, enter the IP address of the server.

(Optional) Edit the UDP Port field. The numbers to the right of the field indicate the range of
integer values that this field supports.

(Optional) Enter an encryption key in the Encryption Key field.

(Optional) Edit the Timeout field. The numbers to the right of the field indicate the range of integer
values that this field supports.

(Optional) Edit the Max Retries field. The numbers to the right of the field indicate the range of
integer values that this field supports.

Click the Insert button.

Editing a RADIUS Server Configuration

To remove a RADIUS server from your configuration:

1.
2.
3.

D

Click the Maintenance menu and select Services. The Services window opens.
Click the Radius Servers tab.

Identify the row of the RADIUS server that you want to reconfigure, then double-click the cell that
you want to edit.

@)

/7
NOTE: You can only edit cells that have a white background.

Edit the content of the cell.
Click the Apply button.

eleting RADIUS Servers

To remove a RADIUS server from your configuration:

1.

2
3.
4

Click the Maintenance menu and select Services. The Services window opens.
Click the Radius Servers tab.

Click the row entry of the RADIUS server that you want to delete.

Click the Delete button.
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Enabling HTTP Services

To configure HTTP services:

O © =N kW=

Click the Maintenance menu and select Services. The Services window opens.
Click the HTTP tab.

Check the Enable HTTP Server checkbox.

(Optional) Assign a port in the HTTP Port field.

(Optional) Check the Enable HTTP Polling checkbox.

(Optional) Check the Enable HTTPS Server checkbox.

(Optional) Assign a port in the HTTPS Port field.

Select a security method from the Secure Cert Common Name field.

Click the Apply button.

Customizing the Boot Configuration

Customize the boot configuration to:

View the image that the switch will boot during the next reboot.
Delete the startup configuration.

Overwrite the startup configuration with another configuration file in your file system.

Configuring Reboot Image

To choose the image that the switch loads when it reboots:

1.
2.

3.

Click the Maintenance menu and select Boot Config. The Boot Configuration window opens.

From the Image Source For Next Reboot pulldown menu, select the image that you want the
switch to load when it reboots.

Click the Apply button in the Software Images partition.

Deleting or Overwriting the Startup Configura-
tion

1.
2.

Click the Maintenance menu and select Boot Config. The Boot Configuration window opens.

(Optional) Click the Overwrite startup configuration with radio button, then select a
configuration from the pulldown menu to replace the current startup configuration with another
configuration file.

@)
/

NOTE: To overwrite your startup configuration with your running configuration, refer to
“Backing Up the Running Configuration File” on page 30.

(Optional) Click the Delete startup configuration radio button to configure your switch to use the
factory default startup configuration.

Click the Apply button in the Startup Configuration partition.
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Backing Up the Running Configuration File

To save your running configuration file:

1. Click the Maintenance menu and select Backup Config. The Backup Configuration window
opens.

2. Enter a file name in the Save Configuration As field. EM will save your running configuration in
the config directory with the name that you specify.

@)

/7

NOTE: Enter startup-config in this field if you want to save the running configuration as the
startup configuration. This process overwrites the existing startup configuration file.

3. Click the Save button.

Viewing Files in the File System

To view files, such as image files, log files, and configuration files, that reside on your device:

1. Click the Maintenance menu and select File Management. The File Management window
opens. Table 5-4 lists and describes the fields in the Current Files on System table.

Table 5-4: Current Files on System Table Fields

Field Description

Slot ID Slot of the controller card on which the file resides.

File Name |Name of the file.

File Type |Type of file. The following types may appear:

* config
+ log
* image
Size Size of the file, in bytes.
Date Most recent date and time that your device or a user updated the file.

2. (Optional) Click the Refresh button to poll your switch and update your display to reflect the most
current inventory of your file system.

Deleting Files in the File System

To delete files from your file system:

1. Click the Maintenance menu and select File Management. The File Management window
opens.

2. Click the line in the Current Files on System table that lists the file that you want to delete, then
click the Delete button. A Delete File window opens.

3. Click the Yes button.

Understand Configuration Files

A configuration file is a text file that stores a list of CLI commands.
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About the Startup-Config

The main configuration file is called startup-config. This file stores all of the CLI commands necessary
to completely configure a box from a factory default state. This configuration file can be copied, backed
up, and modified.

About the Running-Config

Whenever configuration changes are made via the GUI or CLI, a CLI command is temporarily saved in
a virtual configuration file called running-config. If the administrator wishes to save these changes
permanently, this file is “copied” into the startup-config file.

Any number of configuration files can be stored. For convenience and rapid configuration, files can also
maintain a partial list of CLI commands. These can also be copied into running-config for immediate
use or startup-config for persistent use across reboots.

Understanding Log Files

Log files are text files that record activity, including configuration changes. Depending on size, log files
are rotated and compressed. Log files can also be exported from the switch by using the copy command.

File Management and Storage

The management of log files is performed automatically, but can be configured. Log files are stored
separately from other file types, but all files share the 128 MB of flash memory. Log files are stored in
syslog files.

The system checks the size of the active log file hourly, and when it exceeds 1 MByte, the active log
file, ts_log, is closed, compressed, and renamed ts_log.1.gz. Other ts_log.x.gz files are incremented by
1. These files can be downloaded via the Log Viewer GUI, which can create filters for troubleshooting
and auditing purposes.

About Message Types

The following levels of logging are captured:

¢ CONF - configuration changes. No user action is required.

* INFO - general information. No user action is required.

*  WARN - abnormal condition. User intervention may be required.
*  ERROR - abnormal condition. User intervention is required.

¢« FATAL - abnormal condition. User must reboot.

Installing Software Images

To skip directly to the instructions, refer to “Installing a Software Image” on page 33. The sections that
follow provide context and details about installing images.

About the System Image

The Image data that is used to configure the software is being continuously updated and enhanced. Use
the latest system image data to ensure the most efficient usage of your system.

Refer to the user’s support portal at support.hp.com for the latest upgrades.
What is a System Image?

A system image is an unpacked and installed image file. An image file is the source from which to
install a system image and it has an .img extension.
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When an image file is installed, the image file is expanded into a “system image.” The system image is
what the user will refer to in order to specify what the system should use to boot up each card in the
system.

What is an Image File?

Image files are stored in flash memory as a single complete file with a switch “.img” extension. Each
image file contains all the operating software (application software and firmware/microcode) needed by
the various cards that can be installed into the switch.

The switch cannot use an image file directly to boot up the system. The image file must first be
installed. The installation process automatically unbundles the image file and distributes the software
components to each card in the switch. Users do not have to be aware of individual software
components. The user simply executes one CLI command to install an image file. Refer to the install
command in the HP 24-Port 4x Fabric Copper Switch Command Line Interface Reference Guide.

The switch OS stores up to three images on a disk: the uninstalled image, the current system (or
installed) image, and the recovery image.

The switch only has enough flash memory to store:

e one system image file (active)

*  one image file (inactive/uninstalled)

e  one recovery image

Occasionally, you will have to manually delete an image file from the IB system to make room for a

new version. Refer to “Deleting Files in the File System” on page 30.

Inactive Image

An inactive image is one that has been downloaded, but has not been installed; therefore it is not the
active, or system image.

The OS can only store one inactive image. Delete inactive images through the CLI (refer to “Deleting
Files in the File System” on page 30), or by clicking the delete button in EM.

Active Image

The term “active image” refers to the current system image. An installed, or active image has gone
through the entire upgrade process. The system image usually has a slash (/) in its name. Do not modify
or delete the installed system image.

Recovery Image

The recovery image is a default image that comes installed on the switch. The recovery image can be
used to quickly restore operation to the system if an image upgrade should fail.

About the Version Numbers

The OS and installed system image running on the IB system determine the supported software features.
Two types of system images are provided:
*  One for the HCA card

*  One for the Topspin 90/Cisco SFS 3001, Topspin 120/Cisco SFS 7000, Topspin 270/Cisco SFS
7008, or Topspin 370/Cisco SFS 7008

Before configuring the IB system, check the version of the installed system image used to boot the
chassis. Use this information to ensure that you upgrade to the correct software.
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About Copying/Downloading the Image

Upgrading the switch OS requires several steps, which are described in the following sections. One of
the steps will be to copy the image before installing it. Table 5-5 identifies options when copying the
image into the system.

Table 5-5: Copying/Downloading Image Options

Through the CLI| Through the GUI
FTP Remote FTP Server
TFTP Local File

Card Status Requirements

Only cards with an oper-status of “up” are updated. If a card is down when you run install, or a card is
added after running install:

1. Bring up the card.

2. Run install again.

3. Specify the same image file. If the image is already installed on a card, that card is skipped.
4

Be sure to specify the boot-config again so that all cards know to boot from the same system image.

Upgrade Procedure Overview

The system upgrade process is summarized in the following steps:
1. Set up the hardware connection for the upgrade.
2. Verify the installed system-image version number.
3. Do one of the following:
*  Download an image file from a network-accessible ftp server.
*  Download an image file remotely from a tftp server.
4. Install the new system-image.
Configure the CLI and EM to use the appropriate configuration file the next time they reboot.
6. Reboot the system.

Installing a Software Image

To install an image file:

1. Click the Maintenance menu and select File Management. The File Management window
opens.

e

NOTE: If you have not already imported an image file to your file system, refer to “Importing
Configuration Files and Image Files” on page 34.

2. Click the line in the Current Files on System table that lists the file that you want to install, then
click the Install button. A verification window opens.
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7/
NOTE: Before you install an image, verify that you have brought up all of the cards on the chassis

that you want to run the new image. Cards that run a different image from the chassis cannot pass
traffic.

O

/

NOTE: Alert other users that you plan to install a new image on your switch.

Click the Yes button to install the image.

Importing Configuration Files and Image Files

You can import files to your switch from your local host or a remote FTP server.

Importing from a Remote Server

To import files to your switch from remote devices:

1.

v

6.
7.
8
9

Click the Maintenance menu and select File Management. The File Management window
opens.

Click the Import button. The Import File window opens.

From the File Type pulldown menu, select the type of file that you want to import (image or
configuration).

Click the Remote FTP Server radio button or the Remote SCP Server radio button.

Enter the DNS name or IP address of the FTP server that holds the file that you want to import in
the Server Name or IP Address field.

Enter the user ID that logs you in to the FTP server in the User Name field.
Enter the password that logs you in to the FTP server in the Password field.
Enter the directory path and name of the file on the FTP server in the File Path and Name field.

Enter the name that the file will take on your switch in the File Name on System field.

10. Click the Copy button.

Importing from Your Local Host

To import files to your switch from your local host:

1.

W
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Click the Maintenance menu and select File Management. The File Management window
opens.

Click the Import button. The Import File window opens.

Select, from the File Type pulldown menu, the type of file that you want to import (image or
configuration).

Click the Local File radio button.

Click the Choose button and navigate to the file that you want to import.

Click the file that you want to import, then click the OK button.

Enter the name that the file will take on your switch in the File Name on System field.

Click the Copy button.
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Exporting Configuration Files and Log Files

You can export files from your switch to your local host or a remote FTP server.

Exporting to a Remote Server

To export files from your switch to a remote device:

1.

8

E

Click the Maintenance menu and select File Management. The File Management window
opens.

Click the Export button. The Export File window opens.
Click the Remote FTP Server radio button or Remote SCP Server radio button.

Enter, in the Server Name or IP Address field, the DNS name or IP address of the FTP server that
will receive the file that you want to export.

Enter, in the User Name field, the user ID that logs you in to the FTP server.
Enter, in the Password field, the password that logs you in to the FTP server.

Enter, in the File Path and Name field, the path on your remote host where you want to copy the
exported file, as well as the name that you want to assign for the file.

Example

/root/files/old-config.cfg
Click the Copy button.

xporting to Your Local Host

To export files from your switch to your local host:

1.

A

Click the Maintenance menu and select File Management. The File Management window
opens.

Click the Export button. The Export File window opens.

Click the Local File radio button.

Click the Choose button.

Navigate to the directory where you want to copy the file, then click the OK button.
Click the Copy button.

Saving a Configuration File

To back up your running configuration to the standby controller on your chassis:

1.

Click the Maintenance menu and select Save Config.

NOTE: If you make configuration changes to the master SM and then save the configuration, verify
that the master and backup have synchronized, then save the configuration on the backup as well. For
more information, refer to “Configuring Database Synchronization” on page 73.
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Rebooting Your Switch

To reboot your switch with EM:

1.
2.

Click the Maintenance menu and select Reboot.
Click the OK button.

Running General Diagnostics

With EM, you can run the following diagnostics:

chassis
card

port

Running Chassis Diagnostics

To run chassis diagnostics:

O 0 =N kWD =

Click the Maintenance menu, then select Diagnostics > General.

Click the Chassis tab.

Click, in the Module Type ficld, the radio button of the type of element that you want to diagnose.
Enter the index number of the element that you want to diagnose in the Module Number field.
Click, in the Test field, the radio button of the type of test that you want to run.

Enter the number of times that you want the test to run in the Iterations field.

Click, in the Action field, the start radio button to begin a test or the stop radio button to end a test.
Click, in the Option field, the error condition that you want to apply.

Click the Apply button to execute the configuration and start or stop the test.

Configuring Card Diagnostics

To run card diagnostics:

A o o B

Click the Maintenance menu, then select Diagnostics > General.

Click the Card tab.

Click the Insert button. The Diagnostic, Insert Card window opens.

Click the Card pulldown menu and select the card that you want to test.

Click, in the Test field, the type of test that you want to execute.

Enter, in the Iterations field, the number of test iterations that you want to run.
Select an action from the Action field:

*  Click the start radio button if you want the test to execute when you click the Insert button
(Step 8.).

e Click the stop radio button if you want the test to appear in the table but not execute. To
execute the test later, refer to “Running Configured Diagnostic Tests” on page 37.

Click the Insert button.
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Deleting a Card Test Entry

To delete a card test entry:

1. Click the Maintenance menu, then select Diagnostics > General.

2. Click the Card tab.

3. Click the row of the entry that you want to delete, then click the Delete button.

Configuring Port Diagnostics

To run port diagnostics:

1. Click the Maintenance menu, then select Diagnostics > General.
Click the Port tab.

Click the Insert button. The Diagnostic, Insert Port window opens.

Enter a port (or ports) in the Port field, or click the “...” button, select ports, and click the OK
button.

S

Click, in the Test field, the radio button of the test that you want to execute.
(Optional) Check the Data Validation checkbox to validate data.
Enter the size, in bits, of the data packet that you want to send in the Data Size field.

Enter the data pattern that you want to iterate in the test in the Data Pattern field.

O © =N W

Enter the number of iterations that you want to execute in the Iterations field.
10. Enter a source LID in the Source ID field.

11. Enter a destination LID in the Target ID field.

12. Select an action from the Action field:

e Click the start radio button if you want the test to execute when you click the Insert button
(Step 8.).

*  Click the stop radio button if you want the test to appear in the table but not execute. To
execute the test later, refer to “Running Configured Diagnostic Tests” on page 37.

13. Click the Insert button.

Deleting a Port Test Entry

To delete a card test entry:

1. Click the Maintenance menu, then select Diagnostics > General.

2. Click the Port tab.

3. Click the row of the entry that you want to delete, then click the Delete button.

Running Configured Diagnostic Tests

To run a diagnostic test that you have already added to the Diagnostics window:

1. Click the Maintenance menu, then select Diagnostics > General.

2. Click the appropriate tab for the test that you want to run.

3. Identify the entry of the test that you want to run.

4. Click the cell in the Action column of that entry and select start from the pulldown menu.

O

7/
NOTE: The cell must display stop for this process to work. If the cell displays start, select stop
from the pulldown menu and click the Apply button, then perform this step.
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5. Click the Apply button, then repeatedly click the Refresh button to track the progress of the test.

Viewing POST Diagnostics

You can view POST diagnostics for the following elements:
* cards
e power supplies

e fans

Card

To view card POST diagnostics:
1. Click the Maintenance menu, then select Diagnostics > POST.
2. Click the Card tab. Table 5-6 lists and describes the fields on this tab.

Table 5-6: Card POST Fields

Field Description

Slot ID Slot number.

POST Status Indicates the result of POST (Power-on-self-test):
* unknown
* passed
» failed

PostErrorCodes Show error(s) detected during POST.

Power Supply

To view power supply POST diagnostics:
1. Click the Maintenance menu, then select Diagnostics > POST.

2. Click the Power Supply tab. Table 5-7 lists and describes the fields on this tab.

Table 5-7: Power Supply POST Fields

Field Description

PSID Power supply number.

POST Status Indicates the result of POST (Power-on-self-test):
* unknown
* passed
+ failed

PostErrorCodes Show error(s) detected during POST.




Fan

To view fan POST diagnostics:
1. Click the Maintenance menu, then select Diagnostics > POST.
2. Click the Fan tab. Table 5-8 lists and describes the fields that appear.

Table 5-8: Fan POST Fields

Field Description

Fan ID Fan number.

POST Status Indicates the result of POST (Power-on-self-test):
* unknown
* passed
» failed

PostErrorCodes Show error(s) detected during POST.

Viewing FRU Diagnostics

You can view FRU diagnostics for the following elements:
e cards
*  power supplies

e fans

Card

To view card FRU diagnostics:
1. Click the Maintenance menu, then select Diagnostics > POST.
2. Click the Card tab. Table 5-9 lists and describes the fields on this tab.

Table 5-9: Card POST Fields

Field Description

Slot ID Slot number.

FruError Shows the last hardware error (if any) detected on this FRU. The
information returned in this variable is read from the device's VPD.

Power Supply

To view power supply FRU diagnostics:
1. Click the Maintenance menu, then select Diagnostics > POST.
2. Click the Power Supply tab. Table 5-10 lists and describes the fields on this tab.

Table 5-10: Power Supply POST Fields

Field Description

PSID Power supply number.

FruError Shows the last hardware error (if any) detected on this FRU. The
information returned in this variable is read from the device's VPD.

39



40

Fan

To view fan FRU diagnostics:
Click the Maintenance menu, then select Diagnostics > POST.
Click the Fan tab. Table 5-11 lists and describes the fields this tab.

1.
2.

Table 5-11: Fan POST Fields

Field Description
Fan ID Fan number.
FruError Shows the last hardware error (if any) detected on this FRU. The

information returned in this variable is read from the device's VPD.
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Health Menu Tasks

The following sections appear in this chapter:

Introduction

“Introduction” on page 41

“Viewing Health Summary” on page 41

“Viewing Power Supply Status” on page 42

“Viewing Fan Status” on page 42

“Viewing Sensor Status” on page 43

“Configuring Your Host as a Trap Receiver” on page 45

“Viewing Logs” on page 46

The Health menu provides options that let you verify the status of your Server Switch. With Health
menu options, you can view the operational status of Server Switch and view logs of Server Switch
events.

Viewing Health Summary

To view a summary of the health of your Server Switch:

1.
2.

Click the Health menu and select Status. The Health Status window opens.
Click the Summary tab. Table 6-1 lists and describes the fields on this tab.

Table 6-1: Summary Tab Fields

Field

Description

Up Time

Displays amount uptime of the switch since the last reboot.
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Table 6-1: Summary Tab Fields

Field Description

Power | Displays a green check if all power supplies function successfully. Displays ared X if a
power supply experiences a problem.

Fans Displays a green check if all fans function successfully. Displays a red X if a fan
experiences a problem.

Sensors |Displays a green check if all temperature sensors function successfully. Displays a red
X if a temperature sensor experiences a problem or if the temperature exceeds the safe
threshold.

Viewing Power Supply Status

To view the status of the power supplies on your Server Switch:

1.
2.

Click the Health menu and select Status. The Health Status window opens.
Click the Power Supplies tab. Table 6-2 lists and describes the fields on this tab.

Table 6-2: Power Supplies Tab Fields

Field Description

PSID Numeric identifier of the power supply. For more information on the
power supplies in your device, refer to your hardware documentation.

Type Type of power (AC or DC).

Oper Status Displays up to indicate that your power supply functions and currently
supplies power to your device. Displays down for faulty power
supplies.

Utilization Percentage of total power supply resources in use.

Voltage Voltage of the power supply.

Product Serial Number

Factory-assigned product serial number.

PCA Serial Number Printed circuit assembly (PCA) serial number.
PCA Assembly Number |Printed circuit assembly (PCA) assembly number.
FRU Number Field replaceable unit (FRU) number.

Viewing Fan Status

To view the status of the fans on your Server Switch:

1.
2.

Click the Health menu and select Status. The Health Status window opens.
Click the Fans tab. Table 6-3 lists and describes the fields on this tab.

Table 6-3: Fans Tab Fields

Field Description

Fanld Numeric identifier of the fan. For more information on the fans in your
device, refer to your hardware documentation.

OperStatus Displays up if the fan functions properly; otherwise, displays down.

Speed Displays the speed of the fan in percentage of maximum speed.

ProductSerialNum Factory-assigned product serial number.
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Table 6-3: Fans Tab Fields

Field Description

PcaSerialNum Printed circuit assembly (PCA) serial number.
PcaAssemblyNum Printed circuit assembly (PCA) assembly number.
FruNum Field-replaceable unit (FRU) number.

Viewing Sensor Status

To view the status of the temperature sensors on your Server Switch:
1. Click the Health menu and select Status. The Health Status window opens.
2. Click the Sensors tab. Table 6-4 lists and describes the fields on this tab.

Table 6-4: Fans Tab Fields

Field Description

Slot ID Numeric identifier of the slot in which the temperature sensor resides.
For more information on the slots in your device, refer to your
hardware documentation.

Sensor ID Numeric identifier of the temperature sensor.

Oper Status Operational code of the sensor. This field displays normal, tempAlert,
currAlert, or voltAlert.

Oper Code Temperature of the slot.

Current Temp Current temperature of the chassis.

Alarm Temp Chassis temperature that triggers an alarm.

Shutdown Temp Chassis temperature that triggers a shutdown.

Viewing Server Switch Events

When you configure your local host to receive Server Switch events, you can then view a log of the
events. Before you view Server Switch events, refer to “Configuring Your Host as a Trap Receiver” on

page 45.

To view Server Switch events on a host that you have configured to receive events, click the Health
menu and select Event Viewer. The Event Viewer window opens. Table 6-5 lists and describes the

fields in the window.

*  (Optional) Click the Node column header to organize the Event Viewer table by node. Click the
header a second time to reverse the order (from top to bottom) of the display.

e (Optional) Click the Time column header to organize the Event Viewer table by node. Click the
header a second time to reverse the order (from top to bottom) of the display.

*  (Optional) Click the Type column header to organize the Event Viewer table by node. Click the
header a second time to reverse the order (from top to bottom) of the display.

*  (Optional) Click the Description column header to organize the Event Viewer table by node. Click
the header a second time to reverse the order (from top to bottom) of the display.

Table 6-5: Event Viewer Fields

Field Description

Node IP address of the Server Switch on which the event took place.
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Table 6-5: Event Viewer Fields

Field Description

Time Time that the event took place.
Type Type of event that took place.
Description |Description of the event.

Exporting Event Logs to a Text File

To export an event log:

1. Click the Health menu and select Event Viewer. The Event Viewer window opens.
2. Click the Export button. The Save window opens.

3. Navigate to the folder on your local host on which you want to store the event log.

4

Enter a file name for the log in the File Name field, then click the Save button. EM creates a text
file with the contents of the event log on your host.

Clearing Event Entries by Category

To clear select event types from the Event Viewer table:
1. Click the Health menu and select Event Viewer. The Event Viewer window opens.

2. Click the Clear button, then click the type of entry that you want to remove from the table. All
entries of that type disappear from the display.

Clearing All Event Entries

To clear all events from the Event Viewer table:
1. Click the Health menu and select Event Viewer. The Event Viewer window opens.

2. Click the Clear button, then click All. All event entries disappear from the display.

Configuring Trap Receivers

You must configure your host to receive traps in order to view events. If no other application on your
local host controls port 162, EM automatically registers your local host as a trap receiver. To verify that
EM registered your host:

1. Click the Health menu, then click Trap Receivers. The Trap Receivers window opens.

2. Verify that the IP address of your host appears in the Address column. If it appears, verify that true
appears in the Receive Events column.

NOTE: If your local host has multiple IP addresses (for example, one from a LAN and one from a
wireless connection, disable all IP addresses other than the LAN address, then close EM and open it
again. Verify that only the LAN address appears in the Trap Receivers window. If it appears, you can
enable your other addresses.
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Configuring Your Host as a Trap Receiver

If you have an application (other than EM) that takes over port 162 to receive and manage SNMP traps,
you must add your host to the Server Switch configuration with EM. This allows the application to
receive Server Switch traps. To add your host as a trap receiver:

1.

2
3.
4.
5

Click the Health menu and select Trap Receivers. The Trap Receivers window opens.

Click the Insert button. The Insert Trap Receivers window opens.
Enter the IP address of your host in the Address field.

Enter the SNMP community of your host in the Community field.
Check the Receive Events checkbox, then click the Insert button.

Deleting Your Host as a Trap Receiver

If you manually configured your host as a trap receiver, you must manually remove your host to
de-register. To delete your host as a trap receiver:

1.
2.
3.

Click the Health menu and select Trap Receivers. The Trap Receivers window opens.

Click your host in the Trap Receivers table, then click the Delete button.

Click the Close button.

Viewing Authentication Failures

To view authentication failures:

1.

Click the Health menu and select Authentication. The Authentication window opens. Table 6-6
lists and displays the fields in this window.

Table 6-6: Authentication Fields

Field

Description

Enable Authentication Traps

Provides radio buttons to enable and disable authentication
traps.

CLI Access Violation Count

Number of CLI access violation counts.

CLI Last Violation Time

Time of the most recent CLI access violations.

SNMP Access Violation Count

Number of SNMP access violation counts.

SNMP Last Violation Time

Time of the most recent SNMP access violations.

HTTP Access Violation Count

Number of HTTP access violation counts.

HTTP Last Violation Time

Time of the most recent HTTP access violations.

Enabling Failure Traps

To enable authentication traps:

1.
2.

Click the Health menu and select Authentication. The Authentication window opens.

Click the enabled radio button, then click the Apply button.
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Viewing Logs

To view one of the logs in the file system on your Server Switch:

1.
2.
3.

1.

2.
3.
4

Click the Health menu, then click Log Viewer. The Log Viewer window opens.

Click the Download button. The Download Log Files window opens.

Click, in the Available log files table, the log that you want to view, then click the Download
button. The Save As window opens.

Navigate to the directory in which you want to save the log file, then click the Save button. A
Download Complete window opens and displays an Open File checkbox.

Check the Open File checkbox, then click the OK button. The log opens in the Log Viewer
window.

Applying Filters to ts_log Displays

When you configure and apply filters, EM removes from the display all entries that do not match the
filter criteria. To remove particular entries from log displays:

Click the Health menu, then click Log Viewer. The Log Viewer window opens.

Open a ts_log file. For detailed instructions, refer to “Viewing Logs” on page 46.
Click the Filter button. The Log Filter window opens.

Select the filter attributes that you want to apply. Note the following:

All filter options are cumulative. If you choose slot 1 and WARN, the log viewer only displays
logs that apply to slot 1 and are of the WARN type. Any WARN type messages that do not
apply to slot 1 do not appear. Any slot 1 messages of other types do not appear.

Click the Show Advanced button to reveal application options that you can add to the filter.
Click an application to apply it to the filter. Press and hold the Ctrl key and click additional
applications to apply multiple applications to the filter.

Click the Apply button. All entries that do not match the filter disappear from the display.
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Report Menu Tasks

The following sections appear in this chapter:
*  “Introduction” on page 47

*  “Viewing Port Statistics” on page 47

e “Graphing Port Statistics” on page 49

Introduction

Use the Report menu to view port statistics. The menu allows you to view all relevant statistics in a
table, or to select statistics to create a custom graph.

Viewing Port Statistics

To view port statistics:
1. In the chassis display, click the port whose statistics you want to view.

2. Click the Report menu and select Graph Port. A window opens that displays the type and number
of the port.

3. Click the Interface tab. A table of port statistics appears. Table 7-1 lists and describes the fields in
this table.

Table 7-1: Port Statistics Display Fields

Field Description
InOctets Cumulative number of octets that arrived at the port, including framing
characters.

InUcastPkts Cumulative number of incoming packets destined for a single port.
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Table 7-1: Port Statistics Display Fields

Field

Description

InMulticastPkts

Cumulative number of incoming packets destined for the ports of a
multicast group.

InBroadcastPkts

Cumulative number of incoming packets destined for all ports on the
fabric.

InDiscards

Cumulative number of inbound packets that the port discarded for a
reason other than a packet error (for example, lack of buffer space).

InErrors

Number of inbound packets with errors that the port discarded.

InUnknownProtos

For packet-oriented interfaces, the number of packets received via the
interface that were discarded because of an unknown or unsupported
protocol. For character-oriented or fixed-length interfaces that support
protocol multiplexing, the number of transmission units received via the
interface that were discarded because of an unknown or unsupported
protocol. For any interface that does not support protocol multiplexing,
this counter is always 0.

OutOctets

Total number of octets transmitted out of the interface, including framing
characters.

OutUcastPkts

Total number of packets that higher-level protocols requested be
transmitted, and which were not addressed to a multicast or broadcast
address at this sub-layer, including those that were discarded or not sent.

OutMulticastPkts

Total number of packets that higher-level protocols requested be
transmitted, and which were addressed to a multicast address at this
sub-layer, including those that were discarded or not sent. For a MAC
layer protocol, this includes both Group and Functional addresses.

OutBroadcastPkts

Total number of packets that higher-level protocols requested to be
transmitted, and which were addressed to a broadcast address at this
sub-layer, including those that were discarded or not sent.

OutDiscards

Number of outbound packets that were chosen to be discarded even
though no errors had been detected to prevent their being transmitted.
One possible reason for discarding such a packet could be to free-up
buffer space.

OutErrors

For packet-oriented interfaces, the number of outbound packets that
could not be transmitted because of errors. For character-oriented or
fixed-length interfaces, the number of outbound transmission units that
could not be transmitted because of errors.

Configuring Refresh Rate

EM refreshes all statistics displays at regular intervals. To configure the interval:

1.
2.

In the chassis display, click the port whose refresh rate you want to change.

Click the Report menu and select Graph Port. A window opens that displays the type and number

of the port.

Click the pulldown menu at the bottom of the window and select the interval at which you want the

display to refresh.

e

NOTE: You do not need to click any Apply or OK button. The change takes place immediately.
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Graphing Port Statistics

EM provides utilities that create line charts, area charts, bar charts, and pie charts to visually represent
port statistics.

To graph particular port statistics:

1.
2.

In the chassis display, click the port whose statistics you want to view.

Click the Report menu and select Graph Port. A window opens that displays the type and number
of the port.

Click the Interface tab. (Optionally, you can click the IP, Ethernet, or FibreChannel tabs, when
available.) A table of port statistics appears.

Select the values that you want to include in the graph using one of the following methods:
*  Click and drag your cursor across the values that you want to graph.
*  Hold the Ctrl key and click the values that you want to graph.

Example

‘35 Ethernet Port 10/1 - 10.3.0.69

| Interface | Ethernet | IP

Abhzolteialle Cumulative Awverage Minimum Maximum' Lastvalue
hoctets 20,790 456

InUcastPkis 2,275 445
IntuticastPkts
|InEiru:uadn::astF‘kts 1 466 723
|InDis:::ards
|InErrn:|rs

=

InUnknowynProtos
OutOctets
OutlcastPkts
CuthdutticastPkis
OutBroadcaztPkts 4,343
OutDizcards 0
OutErrors 0

o e e e e e e e e e e

Lo 0 e e e e e e e e e e

Lo O e o e e s e e e e e
oo o oo ool oo

o s o e e e e e e e e

1]

[@ g Etapsed: 00:16:29

Click the button of the graph that you want to create.
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Pie Chart

Figure 7-1: Graph Buttons

The graph appears.

Example

k) Ethernet Port 1071 - 10.3.0.69 Interface, AbsoluteValue M=

M nUcastPkts | InBroadcastPits Il OutOctets

@)
4
NOTE: With most charts, the display will reload with updated information based on the refresh

rate. To configure the interval, refer to “Configuring Refresh Rate” on page 48.

Swapping Chart Type, Layout, and Scale

With the exception of pie charts, the chart display lets you:
*  Swap between charts.
* Increase or decrease the scale of the display.

*  View the chart horizontally or vertically.

To perform these functions, use the buttons in Table 7-2.

Table 7-2: Chart Buttons

Button |[Name Function

=0 Stacked Overlays the graphical output of each statistic.




Table 7-2: Chart Buttons (Continued)
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Button |Name Function
E Horizontal |Rotates the axis of the graph by ninety degrees.
1 Log Scale |Zooms in and out.
¥l
EE Line Chart |Displays a line chart.
[:I Area Chart |Displays an area chart.
Bar Chart |Displays a bar chart.

=
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InfiniBand Menu Tasks

The following sections appear in this chapter:

*  “Introduction” on page 54

*  “Viewing Subnet Manager Properties” on page 59

e “Viewing Database Synchronization Details” on page 62
*  “Understanding Partitions” on page 63

*  “Viewing Partition Details” on page 66

e “Viewing Multicast Group Details” on page 67

e “Viewing Multicast Member Details” on page 68

*  “Viewing InfiniBand Services” on page 68

e “Viewing Switch Route Details” on page 69

*  “Viewing Switch Element Route Details” on page 69
¢ “Adding a Subnet Manager” on page 70

e “Configuring Subnet Manager Properties” on page 70
*  “Configuring Database Synchronization” on page 73
*  “Viewing the Database Synchronization State” on page 75
e “Viewing Partitions” on page 76

*  “Viewing Multicast Groups” on page 78

*  “Viewing Infiniband Services” on page 80

e “Viewing InfiniBand Routes” on page 80

*  “Enabling Performance Management” on page 81

*  “Monitoring Connections” on page 81

e “Viewing Port Counters” on page 86

*  “Enabling Port Monitoring” on page 88
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*  “Launching Topology View” on page 90
e “Viewing Subnet Details” on page 92
e “Viewing Subnet Management Agents” on page 95

*  “Viewing Device Management” on page 103

Introduction

This section provides information to familiarize you with the InfiniBand technology. For hardware-
specific information, consult the relevant hardware documentation.

What is InfiniBand?

InfiniBand (IB) is a high speed, high density serial interconnect that increases CPU utilization,
decreases latency, and eases the management pain of data centers. The term InfiniBand refers to the
entire hardware, communication, and management infrastructure. Use of this technology increases the
communication speed between the following:

« CPUs
¢ devices within servers

*  subsystems located throughout a network

How Does InfiniBand Work?

IB combines high-speed hardware, specialized protocols, and Remote Direct Memory Access (RDMA)
techniques to increase CPU utilization and decrease latency. Operations of the IB Architecture are
managed by the subnet manager (SM).

InfiniBand Components

One or more of the following hardware components may be used to maximize your server network:
* B switch—passes traffic between IB-capable devices over the IB network

*  Host Channel Adapters (installed in host)—serves an IB version of a network interface card (NIC)
to connect the host to the IB network

Protocols
IB requires a new set of protocols. All of the necessary protocol drivers are included with the solution.

IPolB

The IP over IB (IPoIB) link driver provides standardized Internet Protocol encapsulation over IB
fabrics. [PolIB can transparently use IP over IB technology, similar to the way that IP runs over Ethernet.

The primary responsibilities of the IPoIB driver are to perform address resolution and the management
of multicast membership.

SDP

The Sockets Direct Protocol (SDP) is a transparent protocol used on IB networks to allow sockets-based
applications to take advantage of the RDMA performance over an IB network.

SDP provides:
* areduction in the amount of software running inside a process context

e Zero copy
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SDP protocol support enables databases, application servers, and CPUs to operate more efficiently
because the databases spend less time waiting for work, the application servers spend less time waiting
for responses, and the CPUs have more cycles free for other work.

SRP

SCSI RDMA Protocol (SRP) is an upper-layer storage protocol for IB. It runs SCSI commands across
RDMA-capable networks for IB hosts to communicate with FC storage devices. This protocol allows
IB hosts to natively send SCSI commands as if the storage was direct attached.

The SRP protocol is designed to operate using an RDMA communication service. An RDMA
communication service provides communication between pairs of consumers; it uses messages for
control information and RDMA operations for data transfers.

The SRP protocol is only used if you have a FC gateway installed in your IB system.

uDAPL

The user Direct Access Programming Library (uDAPL) is a standardized user mode API that natively
supports IB fabrics.

uDAPL performs name-to-address translations, establishes connections, and transfers data reliably.
The primary responsibilities of uDAPL are:
+  Connection management

* Low latency data transfer and completion

Architectural Elements

The following structures serve as foundational elements of IB architecture:
*  Remote Direct Memory Access (RDMA)
*  Queue Pairs

e Services

RDMA

IB utilizes Remote Direct Memory Access (RDMA) technology. RDMA is a technology that allows one
computer to place information directly into the memory of another computer.

RDMA is specifically characterized by two important features:
» allows user space applications to directly access hardware

*  zero-copy data movement

A combination of hardware and software allows user space applications to read and write the memory
of a remote system without kernel intervention or unnecessary data copies. Applications place most of
the messaging burden upon IB’s high-speed network hardware. This results in lower CPU utilization per
I/0 operation and more efficient use of machine resources.

Queue Pairs

A “verb” is the abstract description that is used to define the functionality of the Host Channel Adapter
(HCA). A “verb consumer” refers to the direct user of the verb.

A Work Queue allows a verb consumer to queue up a set of instructions that is executed by the Channel
Adapter. There are two types of Work Queues: Send Work Queue (outbound) and Receive Work Queue
(inbound). Together these Work Queues create a Queue Pair (QP).

Send and Receive Work Queues are:

» always created as a pair.
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* always remain a pair.

e identified by a QP number, which is within the Channel Adapter.

The QP is an addressable entity and is one of the primary architectural elements of IB. In IB,
communication occurs between QPs, instead of between ports. The QP is the mechanism by which you
define quality of service, system protection, error detection and response, and allowable services.

QPs have:

* aregion of memory to be used as buffers (numbers of QPs are only limited by memory).

* akey that must match on each incoming packet (the Q_Key) to verify the validity of the packet.
*  (potentially) a Partition Key, which specifies the portion of the fabric that this QP may access.

A connection is made by linking a local QP to a remote QP. Applications do not share QPs; therefore,
once you set them up, you can manage them at the application level without incurring the overhead of
system calls.

The channel adapter hardware, which executes a queued set of instructions, takes over the task of
arbitrating communication in two ways: multiplexing access to the send queue or de-multiplexing
messages on the receive queue.

Services

Each QP is independently configured for a particular type of service. These service types provide
different levels of service and different error-recovery characteristics.

The available transport-service types include:
*  Reliable connection

*  Unreliable connection

* Reliable Datagram

*  Unreliable Datagram

Once the fabric connections are discovered, QPs and protection domains are established, and the type
and quality of service are defined for each QP, the fabric operates reliably and securely at full
performance without impact on system hardware or software resources.

Understanding the Subnet Manager

The subnet manager (SM) configures and maintains fabric operations. There can be multiple SMs, but
only one master. The SM is the central repository of all information that is required to set up and bring
up the IB fabric.

The master SM:

»  Discovers the fabric topology.

*  Discovers end nodes.

*  Configures switches and end nodes with their parameters, such as:
*  Local Identifiers (LIDs)
*  Global Unique Identifier (GIDs)
*  Partition Key (P_Keys)

*  Configures switch forwarding tables.

*  Receives traps from Subnet Management Agents (SMAs).

*  Sweeps the subnet, discovering topology changes and managing changes as nodes are added and
deleted.
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Subnet Management Agents

Subnet Management Agents (SMA) are part of the SM. An SMA is provided with each node and
process packets from the SM.

If an SM is elected master, all of its components, including Subnet Admin (SA), are implicitly elected
master. If an SM SM ceases to be master, all of its components cease responding to messages from
clients.

Subnet Manager Hot Standby

The master and slave SMs can be synchronized so the information in the master is carried over to the
slave in the event of a fail-over. Refer to “Enabling SM Database Synchronization” on page 73 to
configure SM hot standby.

The hot standby/database sync feature is used to synchronize the databases between SMs running on
separate chassis.

The SM maintains a data base in the volatile memory of the master SM containing all required
information.

How is the synchronization done?

The database synchronization is accomplished in two stages:

1. Cold Synchronization—This stage is initiated by the master SM when it is ready to start a
synchronization session with a standby SM. In this stage, all out-of-sync tables are copied from the
master SM to the standby SM.

2. Transactional Synchronization—This stage is entered following successful completion of the cold
synchronization stage. In this stage, all database update transaction requests that are processed by
the master, are replicated to the standby.

What can cause a standby SM to become the master SM?
* A crash of the node running the current master SM
*  Partitioning of the subnet (for example, due to link failure)

*  Graceful shutdown of the master (for example, for maintenance purposes)
What happens when a master SM fails?

In the event of a failure:
1. The standby SM becomes the new master.

2. The new master rebuilds the database from information retrieved during the subnet discovery
phase.

Existing LID assignments are retained, where possible.

4. All ports are reset to force them to re-join multicast groups, re-advertise services, re-request event
forwarding, and re-establish connections.

5. A “SlaveToMaster” event trap is generated to trigger any necessary processing by external
management applications.

Subnet Manager Routing

There are two different concepts associated with IB routing:
*  Routing internally within a switch (hops between switch chips)

*  Routing between whole switches (hops between nodes), also referred to as routing between “switch
elements”

Internal switch routing can be configured to provide the highest performance in passing traffic, and to
minimize the threat of congestion within the switch.
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The routing process proceeds as follows:

1. The SM first discovers all the IB switch chips in the network.

2. The SM groups the internal switch chips within each chassis into a switch element.
3. The SM process continues until all the IB switches are grouped into switch elements.
4

After all the switch chips are grouped, the SM will route the switch elements according to the
routing algorithm discussed in “Minimum Contention, Shortest Path & Load Balancing Algorithm”
on page 58.

5. The internal network of each IB switch is then routed based on the best algorithm for each switch
element.

Multiple Paths

The SM allows you to define the Local Identifier Mask Control (LMC) value per subnet. The default
value of the LMC is 0, so by default only one Local Identifier (LID) is assigned to each host port.

Once the LMC value has been assigned, the SM will route different paths for each LID associated with
the same host port. The result of these paths is based on the routing algorithm applied.

Understanding SM Routing Terms
The following terms are important to understand before distinguishing the various types of algorithms
that the SM uses for routing:

»  Distance—is defined as the number of hops (IB switches or switch elements) between source and
destination.

*  Tolerance—is used when deciding if a particular path is better in distance than the already selected
path. You can select the tolerance to be used for shortest path calculation.

« If'the tolerance is set to 0, this means that a path has equal distance in calculating the route as
the shortest path only if the path and shortest path have an equal number of hops.

«  Ifthe tolerance is set to 1, this means that a path has equal distance in calculating the route as
the shortest path route only if the path has a number of hops equal to either the shortest path or
the shortest path plus 1.

*  Contention—is declared for every switch port on the path that is already used for routing another
LID associated with the same host port.

Minimum Contention, Shortest Path & Load Balancing

Algorithm

Minimum Contention, Shortest Path, and Load Balancing is the algorithm that is used by default to

route between the switch elements and for routing between the internal IB switch chips within each
switch element.
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The following algorithm is used for the calculation:
1. The shortest path for each of the host ports is calculated.

2. Contention is calculated for all the available paths that are within the (shortest path + tolerance)
distance.

a. The path with the least contention is selected.
b. If two paths have the same contention, the path with less distance is selected.

c. Iftwo paths have the same contention and the same distance, the port usage count is used to
provide load balancing over the two paths. The usage count is a measure of how many LIDs have
been configured to use that particular port.

Deterministic Source Based Routing Algorithm

The Deterministic Source Based Routing algorithm is used in some High Performance Computing
(HPC) environments where the requirements may need to be more stringently defined. An administrator
can identify the exact route that a given port and LID takes for traversing through the network.

Configuring Your Network For Optimal Routing

For optimal routing, HP recommends that you:
*  Create equal paths between switch elements.

*  Determine the first path that will be discovered.

It is recommended that IB switch elements be connected so that all paths between any pair of switch
elements are the same distance (in other words, same number of hops), if possible. This enables you to
obtain the optimal paths using the default tolerance of 0. If the paths are of different lengths, then the
tolerance value will need to be determined.

The SM Routing Algorithm selects the first best path that it finds. If multiple paths with the same
properties are available then the first of these paths found is the one that is selected. Therefore, it is
possible to set up the cabling between switch elements to force the algorithm to prioritize certain paths.
Depending on the network requirements, the prioritized paths can either be concentrated on a particular
switch element or spread across multiple switch elements to improve fault tolerance.

Viewing Subnet Manager Properties

To view SM properties:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears. Table 8-1 lists and describes the
fields in this window.

Table 8-1: Subnet Manager Properties Window Fields

Field Description

Subnet Prefix Displays the subnet prefix of the SM.

GUID Displays the GUID of the networking device on which the SM runs.
Status Status of the SM. It may be active or inactive. If active, it is actively

managing subnets. If inactive, it is not managing subnets.

Activity Count Activity counter that increments each time the SM issues a subnet
management packet (SMP) or performs other management activities.

SM Key 64-bit subnet management key assigned to the SM.The default is
£e:80:00:00:00:00:00:00. The SM key serves as the prefix of all
GIDs and “brands” nodes as members of this subnet.
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Table 8-1: Subnet Manager Properties Window Fields (Continued)

Field Description

Priority Priority of the SM relative to other SMs in the IB network. The lower
the number, the greater the priority.

Sweep Interval Specifies how frequently the SM queries the IB fabric for network
changes.

Response Timeout Maximum amount of time that the SM waits for a response after it

sends a packet to a port. If the SM does not receive a response in
time, the SM identifies the port as unresponsive.

Master Poll Interval Interval at which the slave SM polls the master to see if it still runs.

Master Poll Retries Number of unanswered polls that causes the slave to identify the
master as dead.

Max Active SMs Maximum number of standby SMs that the master supports. A value
of 0 indicates unlimited SMs.

LID Mask Control Number of path bits present in the base LID to each channel adapter
port. Increasing the LMC value increases the number of LIDs
assigned to each port to increase the number of potential paths to
reach each port.

Switch Life Time The lifetime of a packet inside a switch.

Switch Link HoQ Life The lifetime of a packet at the head-of-queue of a switch port.
CA Link HoQ Life The lifetime of a packet at the head-of-queue of the host port.

Configuring the Subnet Manager Priority

To configure SM priority:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears.
Highlight the cell value in the Priority column and replace it with the value that you want to apply.
4. Click the Apply button.

Configuring the Subnet Manager Sweep Interval

To configure SM sweep interval:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears.

Highlight the cell value in the Sweep Interval column and replace it with the value that you want
to apply.
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Click the Apply button.

Configuring the Subnet Manager Response
Timeout

To configure SM response timeout:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the Response Timeout column and replace it with the value that you want to
apply.
4. Click the Apply button.

Configuring the Subnet Manager Master Poll
Interval

To configure the interval at which the switch polls the master switch:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the Master Poll Interval column and replace it with the value that you want
to apply.
4. Click the Apply button.

Configuring the Subnet Manager Master Poll
Retries

To configure the number of failed polls that prompts the slave to identify the master as “down”:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the Master Poll Retries column and replace it with the value that you want
to apply.
4. Click the Apply button.

Configuring the Maximum Number of Active
Subnet Managers

To configure the maximum number of active SMs on the IB network:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the Max Active SMs column and replace it with the value that you want to
apply.
4. Click the Apply button.
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Configuring LID Mask Control

To configure LID mask control:

1.

4.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the LID Mask Control column and replace it with the value that you want to
apply.
Click the Apply button.

Configuring Switch Life Time

To configure the lifetime of a packet inside the switch:

1.

4.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the Switch Life Time column and replace it with the value that you want to
apply.
Click the Apply button.

Configuring Switch Link HoQ Life

To configure the lifetime of a packet at the head-of-queue of a switch port:

1.

4,

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the Switch Link HoQ Life column and replace it with the value that you
want to apply.

Click the Apply button.

Configuring CA Link HoQ Llfe

To configure the lifetime of a packet at the head-of-queue of a host port:

1.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Subnet Manager tab. A table of SM properties appears.

Highlight the value in the CA Link HoQ Life column and replace it with the value that you want to
apply.
Click the Apply button.

Viewing Database Synchronization Details

EM provides multiple screens that you can use to configure database synchronization. Configuration
details and field descriptions appear in “Configuring Database Synchronization” on page 73.

1.

2.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Database Sync tab. Details appear in the table below the tab.
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NOTE: Database synchronization is enabled by default.

Understanding Partitions

A partition defines a set of IB nodes that are permitted to communicate with one another. Partitions
provide the following:

*  security
* the ability for a large cluster to be divided and isolated into small “sub-clusters”

*  mapping of IB nodes to selected VLANs

NOTE: With database sync enabled on all chassis, only the chassis running the master SM will accept
partition configuration from the user. For more information, see “Configuring Database
Synchronization” on page 73.

How Partitions Work

A partition defines a set of IB nodes that are permitted to communicate with one another. Each node
may be part of multiple partitions so that a system administrator can define overlapping partitions as the
situation requires. Normal data packets carry a 16-bit P_Key, or Partition Key, that defines a unique
partition. The SM configures each node's Channel Adapter with its set of P_Keys. When a packet
arrives at a node, the Channel Adapter checks that the packet's P_Key is valid based on the SM's
configuration. Packets with invalid P_Keys are discarded. P_Key validation prevents a server from
communicating with another server outside of its partition.

IB partitions are comparable to hardware-enforced security features of conventional I/O networking
technologies, such as Ethernet VLANs and Fibre-Channel zones.

Partition Members

Without members, a partition doesn’t have meaning to the system. Ports are added to the partition, and
become members of that partition. Each port may be part of multiple partitions so that the system
administrator can define overlapping partitions as the situation requires.

At the time a port member is added to the partition, the administrator must decide whether that
particular port will have full or limited membership.

Membership Types

A partition contains a group of members, but different types of members can exist within a single
partition. Partition memberships allows even further control because it defines communication within
the members of that group, and not just outside of it.

There are two types of partition memberships: full membership, and limited membership. A full-
membership partition member can communicate with all other partition members, including other full
members, as well as limited members. A limited-membership partition member cannot communicate
with other limited-membership partition members. However, a limited partition member can
communicate with a full member.

About the Default Partition

The SM automatically configures a default partition, which is always P_Key ff:{f.
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The default partition controls all connected ports, and by default, everything is a full-member of the
default partition. The default p_key cannot be altered or deleted as it is the controlling mechanism that
manages the configuration of all the partitions.

Selecting a P_Key Value

For a list of acceptable P_Key values, refer to Table 6-5 on page 56.

Upon creation, the P_Key value is technically a 15-bit number. However, after the P_Key is created and
the port(s) membership type has been established, the entire value becomes 16-bits. The most
significant bit (MSB) displays the type of membership (0 = Limited member, 1 = Full member).

When assigning a P_Key value, you need to choose four hexadecimal numbers. However, because of
the way that the 16th bit is used, only certain numbers can be used for the left-most variable (the MSB).
For example, do not create two P_Keys:

0 #:# # and 8#:# #, as they will be viewed as the same number by the system.

A, P_Key creation: B. Port mamber is
15-bits added.

X000 000 000 0001 Member-type is

Established
Mode -
P _KEY Tabl
Subnet - e
Manager
1000 (R0 0000 0001
Channel hl
Adapter
1% The first 15=-hits
describe the Partition

[n ]
The 167 bit describes
the Port Membership.

l

Therefore, when you
aentar a 4 digit hex
value, the 16" bit of the
binary equivalent is
initially masked out,
Later, it is used define
the Partition
Membership.

Switching Fabric

Figure 8-1: Partition Keys

Hex to Binary Conversions

The following table is provided to assist in the creation of P_Keys.
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When creating the partition P_Key, enter a hexadecimal value that is the equivalent of 16-bits in binary.
For example, enter 80:00 (hex) to be 10000000000000000 (binary).

The default partition, which cannot be altered, is 7f:ff.

Table 8-2: Binary Conversions

Hexadecimal |Binary
0000
0001
0010
0011
0100
0101
0110
0111
1000
1001
1010
1011
1100
1101
1110
1111

molglalm[r|ele[wlalusrwlw[~]o

Examples of Valid P_Key Values

You can choose your own P_Key values, or you can simply choose your values from the list in the
following table.

Table 8-3: Valid P_Key Numbers

00:01 |00:11
00:02 |00:12
00:03 |00:13
00:04 |00:14
00:05 |00:15
00:06 |00:16
00:07 |00:17
00:08 |00:18
00:09 |00:19
00:10 {00:20

Understanding how P_Keys are Saved

Partition information is saved persistently by the master SM. P_Key information can be synchronized
between the master SM and a slave SM. The synchronization of the SMs means that the partition



66

configuration (as well as other information) is exchanged between the active and standby SMs.
Therefore, the partition configuration will be transferred in the event that an IB switch should fail.

The partition configuration is not saved persistently on a slave SM.

If you have more than one IB switch in your fabric, refer to “Enabling SM Database Synchronization”
on page 73.

If you are configuring one IB switch, it will automatically be the master, and the partition configuration
is saved persistently on the switch.

Viewing Partition Details

To view the attributes of the partitions on your switch:

1. Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

2. Click the Partitions tab. Table 8-4 lists and describes the fields on this tab.

Table 8-4: Partition Fields

Field Description

SubnetPrefix Subnet prefix of the subnet whose partitions you want to view.

Key Partition key of the partition whose members the display prints below.

VectorIndex Index identifier of the vector of the partition. This value is available for
application purposes.

Vector Vector of the partition table in which the partition resides. This value is
available for application purposes.

VectorSize Size, in bytes, of the current vector. This value is available for application
purposes.

VectorElementSize |Size, in bytes, of each element of the vector. This value is available for
application purposes.

LastChange Indicates the time stamp when the partition table was last changed.

Configuring Multicast Groups

To configure multicast groups:

1. Click the Infiniband menu and select Subnet Managerment (tabular format). The Subnet
Manager window opens.

Click the Multicast Group Config tab.

Click the CreateMulticastGroup radio button in the Action field.

Enter an MGID in the Multicast Group ID field.

(Optional) Enter a queue key in the QKey field.

Click a radio button in the MTU field to configure the maximum transmission unit of the group.
Enter a partition key in the PKey field.

Click a data rate radio button in the Rate field.

A P B AN T e

Enter an integer value (between 0 and 15) in the Service Level field.

—_
(=]

. Click a scope radio button in the Scope field.
. Click the Apply button.

—_
—_—
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NOTE: The TClass, Packet Lifetime, Flow Label, and Hop Limit attributes are not relevant as of this
release.

Configure IPolIB Broadcast Multicast Groups

To configure IPolB broadcast multicast groups:

1.

A B G

—_
=)

I1.

Click the Infiniband menu and select Subnet Managerment (tabular format). The Subnet
Manager window opens.

Click the Multicast Group Config tab.

Click the CreateIPolPbroadcastMulticastGroup radio button in the Action field.

Enter an MGID in the Multicast Group ID field.

(Optional) Enter a queue key in the QKey field.

Click a radio button in the MTU field to configure the maximum transmission unit of the group.
Enter a partition key in the PKey field.

Click a data rate radio button in the Rate field.

Enter an integer value (between 0 and 15) in the Service Level field.

. Click a scope radio button in the Scope field.

Click the Apply button.

NOTE: The TClass, Packet Lifetime, Flow Label, and Hop Limit attributes are not relevant as of this
release.

Viewing Multicast Group Details

To view the attributes of the multicast groups on your switch:

1.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Multicast Group tab. Table 8-5 lists and describes the fields on this tab.

Table 8-5: Multicast Group Fields

Field Description

SubnetPrefix  |Subnet prefix of the SM.

MGID The 128-bit multicast GID address for this multicast group.
QKey The 16-bit Q-Key of this multicast group.

MLID The 16-bit LID of this multicast group.

MTU Maximum transmission unit

TClass The Tclass to be used in the GRH if GRH is used.

PKey The 16-bit Partition Key for this multicast group.

Rate Traffic rate of this multicast group.
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Table 8-5: Multicast Group Fields

Field Description

PacketLifeTim |Packet life time of this multicast group.

e

SL Service level of this multicast group.

FlowLabel Flow label to be used on this multicast group if GRH is used.
HopLimit Hop limit to be used on this multicast group if GRH is used.
Scope Scope of this multicast group.

Viewing Multicast Member Details

To view the attributes of the multicast members on your switch:

1.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Multicast Member tab. Table 8-5 lists and describes the fields on this tab.

Table 8-6: Multicast Member Fields

Field Description

SubnetPrefix Subnet prefix of this IB subnet.

MGID The 128-bit multicast GID address for this multicast group.

VectorIndex Index identifier of the particular vector of the multicast member table that
contains the multicast member. This value is available for application
purposes.

Vector Vector of the multicast member table that contains the multicast member.
This value is available for application purposes.

VectorSize Size of the vector, in bytes, of the multicast member table that contains the
multicast member. This value is available for application purposes.

VectorElementSize |Size of the multicast member entry (element) in the multicast member
table. This value is available for application purposes.

LastChange Indicates the time stamp when the multicast member table was last

changed.

Viewing InfiniBand Services

Subnet services provide your IB fabric with various features, such as the ability to run particular
protocols. To view the subnet services on your IB fabric:

1.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Services tab. Table 8-7 lists and describes the fields on this tab.

Table 8-7: Services Fields

Field Description
Subnet Prefix Subnet prefix of the subnet service.
ID Unique identifier that the SM assigns to the service.
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Table 8-7: Services Fields (Continued)

Field Description

GID Services use the same GID as the IB controller (node) on which they run.

PKey Partition key of the node on which the service runs.

Lease Lease period remaining (in seconds) for this service. A value of
4294967295 means the lease is indefinite.

Key The 64-bit service key.

Name Name of the subnet service.

Data Data associated with this service.

Viewing Switch Route Details

Switch routes represent the complete path that traffic takes through the IB fabric from the source LID to
the destination LID. To view the attributes of the switch routes on your switch:

1.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Switch Route tab. Table 8-5 lists and describes the fields on this tab.

Table 8-8: Switch Route Fields

Field Description

SubnetPrefix Subnet prefix of the route.

SourceLID Source LID of the route.

DestLID Destination LID of the route.

VectorIndex Index identifier of the particular vector of the route table that contains
the route. This value is available for application purposes.

Vector Vector of the route table that contains the route. This value is available
for application purposes.

VectorSize Size of the vector, in bytes, of the route table that contains the route.
This value is available for application purposes.

VectorElementSize |Size of the route entry (element) in the route table. This value is
available for application purposes.

LastChange Indicates the time stamp when the route table was last changed.

Viewing Switch Element Route Details

To view the attributes of the switch element routes on your switch:

1.

Click the InfiniBand menu and select Subnet Management (tabular format). The Subnet
Manager window opens.

Click the Switch Element Route tab. Table 8-9 lists and describes the fields on this tab.

Table 8-9: Switch Element Route Fields

Field Description
SubnetPrefix Subnet prefix of this IB subnet.
SourceLID Source LID of the route.
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Table 8-9: Switch Element Route Fields

Field Description
DestLID Destination LID of the route.
VectorIndex Index identifier of the particular vector of the route table that contains the

route. This value is available for application purposes.

Vector Vector of the route table that contains the route. This value is available for
application purposes.

VectorSize Size of the vector, in bytes, of the route table that contains the route. This
value is available for application purposes.

VectorElementSize |Size of the route entry (element) in the route table. This value is available
for application purposes.

LastChange Indicates the time stamp when the route table was last changed.

Adding a Subnet Manager

To add an SM to your switch:

1.

RN

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

In the left-hand navigation bar, click Subnet Managers. The Subnet Managers display appears in
the right-hand portion of the window.

Click the Add button in the bottom-right-hand section of the window. The Add Subnet Manager
window opens.

Enter a subnet prefix in the Subnet Prefix field.
Enter a subnet priority level in the Priority field.
(Optional) Enter a subnet management key in the smKey field.

(Optional) Enter a value in the LID Mask Control field to increase the number of LIDs assigned to
each port to increase the number of potential paths to reach each port.

Click the Add button. The new SM appears in the Summary table in the Subnet Managers
display.

Removing a Subnet Manager

To remove an SM from your switch:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

In the left-hand navigation bar, click Subnet Managers. The Subnet Managers display appears in
the right-hand portion of the window.

Click the SM, in the Summary table in the Subnet Managers display, that you want to remove.
Click the Remove button. The entry disappears from the display and the switch configuration.

Configuring Subnet Manager Properties

SMs provide a number of user-configurable attributes. The sections that follow explain each attribute
and describe how to configure them.
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Configuring SM Priority

Every SM in the IB network carries a priority value, and at any given time the SM with the highest
integer value priority becomes the master SM. To configure the SM priority on your switch:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).

3. Enter an integer value in the Priority field. Remember, the higher the integer value, the higher the
priority.

4. Click the Apply button.

Configuring Sweep Interval

The sweep interval specifies how frequently the SM queries the IB fabric for network changes. To
configure the sweep interval on your switch:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

3. Enter an integer value in the Sweep Interval field. This interval represents the number of seconds
between sweeps.

4. Click the Apply button.

Configuring Response Timeout

The response timeout of an SM specifies the maximum amount of time that the SM waits for a response
after it sends a packet to a port. If the SM does not receive a response in the response-time interval, the
SM identifies the port as unresponsive. To configure the response timeout:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

3. Enter an integer value in the Response Timeout field. The SM measures response timeout in
milliseconds.

4. Click the Apply button.

Configuring the Master Poll Interval

The master poll interval determines the interval at which the slave SM polls the master to see if the
master still runs. To configure the master poll interval:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).

3. Enter an integer value in the Master Poll Interval field. The value represents the interval, in
seconds.

4. Click the Apply button.
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Configuring the Number of Master Poll Retries

The master poll retries value specifies the number of unanswered polls that cause the slave to identify
the master as dead. To configure this value:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).
Enter an integer value in the Master Poll Retries field.

4. Click the Apply button.

Configuring the Maximum Number of Active
Standby SMs that the Master SM Supports

NOTE: As of this release, the master SM supports sysn with only one standby.

To configure an unlimited number of active standby (slave) SMs, enter a value of 0. To configure this
value:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).
. Enter an integer value in the Max active SMs field.
4. Click the Apply button.

Configuring LID Mask Control

LID mask control assigns the number of path bits present in the base LID to each Channel Adapter port.
Increasing the LMC value increases the number of LIDs assigned to each port to increase the number of
potential paths to reach each port. To configure LID mask control:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).
Enter an integer value in the LID Mask Control field.

4. Click the Apply button.

Configuring Switch Life Time

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).
Enter an integer value in the Switch Life Time field.

4. Click the Apply button.
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Configuring Switch Link HoQ Life

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Enter an integer value in the Switch Link HoQ Life field.
4. Click the Apply button.

Configuring Database Synchronization

The database synchronization feature propagates information from the database of the master SM to the
standby SMs. The sections that follow describe how to configure this feature.

NOTE: With database sync enabled on all chassis, only the chassis running the master SM will accept
partition configuration from the user. For more information, see “How Partitions Work™ on page 63.

Enabling SM Database Synchronization

If you are configuring more than one IB chassis in your fabric, it is likely that you will want to enable
database synchronization of the SMs.

NOTE: This features is enabled by default.

Enable SM database synchronization to update standby SMs with information in the master SM.

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Click the Database Sync tab in the right-hand panel of the display.
4. Check the Enable checkbox in the SM Database Synchronization field.
Click the Apply button.

Configuring the Maximum Number of Backup
Subnet Managers to Synchronize

To configure the maximum number of backup SMs that will synchronize with the master SM:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Click the Database Sync tab in the right-hand panel of the display.
4. Enter an integer value in the Max Backup SMs field.
Click the Apply button.
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Configuring Session Timeout

To configure the interval, in seconds, during which a synchronization session status MAD packet must
arrive at the master SM to maintain synchronization:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).
Click the Database Sync tab in the right-hand panel of the display.

4. Enter an integer value in the Session Timeout field. This value determines the timeout duration, in
seconds.

5. Click the Apply button.

Configuring the Poll Interval

To configure the interval, in seconds, at which the master SM polls an active slave SM to verify
synchronization:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Click the Database Sync tab in the right-hand panel of the display.
4. Enter an integer value in the Poll Interval field. This value sets the poll interval, in seconds.
Click the Apply button.

Conflgurlng the Cold Sync Timeout Value

To configure the amount of time, in seconds, that a cold synchronization tries to initiate before it times
out:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).
Click the Database Sync tab in the right-hand panel of the display.

4. Enter an integer value in the Cold Sync Timeout ficld. This value sets the timeout interval, in
seconds.

5. Click the Apply button.

Configuring the Cold Sync Limit Value

To configure the maximum number of cold synchronizations to perform during a given cold sync
period:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).

Click the Database Sync tab in the right-hand panel of the display.

4. Enter an integer value in the Cold Sync Limit field. This value sets the maximum number of syncs
that can occur during the sync period (page 75).
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Click the Apply button.

Configuring the Cold Sync Limit Period

To specify the length of the interval during which cold synchronizations may occur:

1.

5.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Click the Database Sync tab in the right-hand panel of the display.

Enter an integer value in the Cold Sync Limit Period field. This value sets the length of the
interval during which cold syncs may occur.

Click the Apply button.

Configuring the New Session Delay

To specify the amount of time that the master SM waits before it attempts to initiate a synchronization
session with a new SM:

1.

5.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (@).
Click the Database Sync tab in the right-hand panel of the display.

Enter an integer value in the New Session Delay field. This value determines the amount of time, in
seconds, that the master SM waits before it attempts to initiate a synchronization session with a
new SM.

Click the Apply button.

Configuring the Resync Interval

To specify the interval at which the master SM sends a resynchronization request to all active sync
sessions:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Click the Database Sync tab in the right-hand panel of the display.

Enter an integer value in the Resync Interval field. This value specifies the interval, in seconds, at
which the master SM sends a resynchronization request to all active sync sessions.

Click the Apply button.

Viewing the Database Synchronization State

To verify that the master SM and slave SM(s) are in sync:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the SM that you want to configure. Each SM appears in the left-hand navigation window with
an SM icon (©@).

Click the Database Sync tab in the right-hand panel of the display.
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4. View the State field.

Viewing Partitions

To view the partitions on your IB network:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

3. Click the Partitions (&) branch. The Partitions summary appears in the right-hand display.
Table 8-10 lists and describes the fields in this display.

Table 8-10: Partitions Summary Fields

Field Description

Partition Key Partition key (numeric identifier) of the partition.

Full Member Count |Number of full partition members.

Limited Member Number of limited partition members.
Count

Creating a Partition

To create an IB partition:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the Partitions (&) branch.
4. Click the Add button. The Add Partition window opens.
Enter a partition key for the new partition in the PKey field, then click the Add button.

Removing a Partition

To delete a partition:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the Partitions (&) branch.

4. Click the partition, in the Summary display, that you want to remove, then click the Remove
button.

Viewing Partition Details

To view partition details:

1. Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

2. Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.
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Click the plus sign (+) next to the Partitions (&) branch to display all partitions in the left-hand
navigation menu.

Click the partition key of the partition whose details you want to view. The members (full and
limited) of the partition appear in the display.

e

NOTE: To view the GUIDs of the Server Switch management ports in the display, click the Show
Switch Mgmt Ports button. Click the Hide Switch Mgmt Ports button to remove these GUIDs
from the display.

Adding Full Members to a Partition

Full members of a partition can communicate to other full members and to limited members.

Adding Available Members

To add a port from the Available Members pool to a partition as a full member:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the plus sign next to the Partitions (&) branch to display all partitions in the left-hand
navigation menu.

Click the partition key of the partition to which you want to add members. The members (full and
limited) of the partition appear in the display.

Click the port, in the Available Members field, that you want to add to the partition, then click the
right-pointing arrow next to the Full Members field.

Adding Unavailable Members

To add a partition member that does not appear in the Available Members pool:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the plus sign next to the Partitions (@) branch to display all partitions in the left-hand
navigation menu.

Click the partition key of the partition to which you want to add members. The members (full and
limited) of the partition appear in the display.

Click the Add Other button. The Add Other Partition Member window opens.

Enter the GUID of the host that includes the port(s) that you want to add to the partition in the Node
GUID field.

Specify the port(s) that you want to add to the partition in the Port field.
Click the Full radio button, then click the Add button.

Addmg Limited Members to a Partition

Limited members of a partition can communicate with full members of the partition, but not with other
limited members.



78

Adding Available Members

To add a port from the Available Members pool to a partition as a limited member:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the plus sign next to the Partitions (&2) branch to display all partitions in the left-hand
navigation menu.

Click the partition key of the partition to which you want to add members. The members (full and
limited) of the partition appear in the display.

Click the port, in the Available Members field, that you want to add to the partition, then click the
right-pointing arrow next to the Limited Members field.

Adding Unavailable Members

To add a partition member that does not appear in the Available Members pool:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the plus sign next to the Partitions (&) branch to display all partitions in the left-hand
navigation menu.

Click the partition key of the partition to which you want to add members. The members (full and
limited) of the partition appear in the display.

Click the Add Other button. The Add Other Partition Member window opens.

Enter the GUID of the node that includes the port(s) that you want to add to the partition in the
Node GUID field.

Specify the port(s) that you want to add to the partition in the Port field.
Click the Limited radio button, then click the Add button.

Viewing Multicast Groups

To view the multicast groups on your IB network:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose partitions you want to view. The left-hand navigation
menu expands.

Click the Multicast Groups (%) branch. The multicast groups summary appears in the right-hand
display. Table 8-11 lists and describes the fields in this display.

Table 8-11: Multicast Group Summary Field Descriptions

Field |Description

MGID |Numeric multicast group identifier of each multicast group on the IB fabric.

QKey |The 16-bit Q-Key of this multicast group.

MTU |Maximum transmission unit of the multicast group.

PKey |Partition key of the multicast group.
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Viewing Multicast Group Details

To view multicast group details:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose multicast groups you want to view. The left-hand
navigation menu expands.

Click the plus sign next to the Multicast Groups (%) branch to display all groups in the left-hand
navigation menu.

Click the MGID of the multicast group whose details you want to view, then click the General tab.
MC group details appear in the display. Table 8-12 lists and describes the fields in this display.

Table 8-12: Multicast Group General Details Fields

Field Description

QKey The 16-bit Q-Key of this multicast group.

MLID The 16-bit LID of this multicast group

MTU Maximum transmission unit of the multicast group.
TClass The Tclass to be used in the GRH if GRH is used.
PKey Partition key of the multicast group.

Rate Traffic rate of this multicast group.

Packet Life Time |Packet life time of this multicast group.

SL Service level of this multicast group.

Flow Label Flow label to be used on this multicast group if GRH Is used.
Hop Limit Hop limit to be used on this multicast group if GRH Is used.
Scope Scope of this multicast group.

Viewing Multicast Group Members

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose multicast groups you want to view. The left-hand
navigation menu expands.

Click the plus sign next to the Multicast Groups (%) branch to display all groups in the left-hand
navigation menu.

Click the MGID of the multicast group whose details you want to view, then click the Members
tab. MC group members appear in the display. Table 8-13 lists and describes the fields in this
display.

Table 8-13: Multicast Group Members Fields

Field Description

Port GID Global identifier of the member port.

Join State Displays whether the port is a full member or limited member of the group.
Proxy Join Status | Displays true or false.
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Viewing Infiniband Services

To view the IB services that run on your switch:

1.

Click the InfiniBand menu and select Subnet Management. The Subnet Management window
opens.

Click the plus sign (+) next to the SM whose services you want to view. The left-hand navigation
menu expands.

Click the Services (@) branch. Details of IB services appear in the right-hand display. Table 8-14
lists and describes the fields in the Summary section of the display.

Table 8-14: Services Summary Fields

Field Description

Name ASCII identifier of the service

Service Id |Numeric identifier that nodes use to call the service.
Service 64-bit ID of the service.

GID

PKey 16-bit multicast GID address.

Table 8-15 lists and describes the fields in the Details section of the display.

Table 8-15: Services Details Fields

Field Description

Service Name ASCII identifier of the service

Service Id Numeric identifier that nodes use to call the service.

Service GID GID of the node that provides the service.

Service PKey 16-bit P-Key.

Lease Lease period remaining (in seconds) for this service. A value of
4294967295 means the lease is indefinite.

Key 128-bit service key.

Data (8 bit) Header of the data type 8.

Data (16 bit) Header of the data type 16.

Data (32 bit) Header of the data type 32.

Data (64 bit) Header of the data type 64.

Viewing InfiniBand Routes

To view the IB routes that run on your switch:

1.

AT o

Click the InfiniBand menu and select Subnet Management. The Subnet Management window

opens.

Click the plus sign (+) next to the SM whose services you want to view. The left-hand navigation

menu expands.

Click the Routes (=£) branch. IB routes fields appear in the right-hand display.
Enter the source LID of the route in the Source LID field.

Enter the destination lid of the route in the Destination LID field.

Click the Show Route button.




81

7. Click the Switch Route tab. Table 8-16 lists and displays the fields on this tab.

Table 8-16: Switch Route Fields

Field Description

Node Global unique ID of the node.
GUID

In Port Port of ingress.

Out Port  |Port of egress

8. Click the Switch Element Route tab. Table 8-17 lists and displays the fields on this tab.

Table 8-17: Switch Element Route Fields

Field Description

Chassis Global unique ID of the node.
GUID

In Port Port of ingress.

Out Port Port of egress.

Enabling Performance Management

To enable IB-port performance management:

1. Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

2. Click the subnet of the ports that you want to manage (for instance, fe:80:00:00:00:00:00:00). The
Port Counter Configuration display appears in the right-hand pane of the window.

3. Click the Enable radio button.

Disabling Performance Management

To disable performance management:

1. Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

2. Click the subnet of the ports that you want to manage (for instance, fe:80:00:00:00:00:00:00). The
Port Counter Configuration display appears in the right-hand pane of the window.

3. Click the Disable radio button.

Monitoring Connections

To monitor connections, you must do the following:

e “Defining a Connection to Monitor” on page 82

*  “Viewing Monitored Connections” on page 82

*  “Viewing Connection Counters” on page 83

e “Viewing Connection Monitor Counters” on page 83
*  “Testing Connections” on page 83

*  “Viewing Port Counters of Connections” on page 84
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Defining a Connection to Monitor

To create a connection to monitor:

1.

8.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the Connection Counters branch. The Monitored Connection tab appears in the right-hand
pane of the window.

Click the Add button. The Add Connection window opens.
Enter a source LID in the Source LID field.

e

NOTE: To view available source and destination LIDs, return to the main EM display, click the
InfiniBand menu, select Subnet Management (tabular format), then click the SwitchRoute tab.
For more details, refer to “Viewing Switch Route Details” on page 69.

Enter a destination LID in the Destination LID field.
Check the Enable Connection Monitoring checkbox.

NOTE: If this checkbox is not selected, you an view only counter information and cannot view
monitoring information.

Click the Add button. The connection entry appears under the Monitored Connections tab.

Viewing Monitored Connections

These instructions assume that you have already defined connections to monitor. To view monitored
connections:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the Connection Counters branch. The Monitored Connection tab appears in the right-hand
pane of the window. Table 8-18 lists and describes the fields on this tab.

Table 8-18: Monitored Connections Fields

Field Description

Subnet Prefix |Subnet prefix of the monitored connection.

Source LID 16-bit source Local ID of the connection.
Destination 16-bit destination Local ID of the connection.
LID

Error Status Displays unknown, exceeded, or notExceeded to indicate if the error value has
exceeded the threshold that you configured. To configure thresholds, refer to
“Configuring Port Monitoring Thresholds” on page 89.

Util Status Displays unknown, exceeded, or notExceeded to indicate if the utilization value
has exceeded the threshold that you configured. To configure thresholds, refer to
“Configuring Port Monitoring Thresholds” on page 89.




Viewing Connection Counters

To view connection counters:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the plus sign next to the Connection Counters branch. The navigation tree expands.

Click the icon (&) of the connection whose counters you want to view.
Click the Connection Counters tab. Table 8-19 lists and describes the fields on this tab.
@)
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7/

NOTE: Each hop in the display is a port on a node. When connections move through nodes, they
enter the node in one hop (GUID A, port a), and exit in another hop (GUID A, port b). Though the

GUIDs of subsequent hops may match, the ports do not match.

Table 8-19: Connection Counters Fields

the next-hop port.

Field Description
Subnet Prefix Subnet prefix of the subnet on which each hop resides.
Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of

Port Number Port number (on the appropriate node) of the hop.

Viewing Connection Monitor Counters

To view connection monitor counters:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the plus sign next to the Connection Counters branch. The navigation tree expands.

Click the icon (/&) of the connection whose counters you want to view.

Click the Connection Monitor Counters tab. Table 8-20 lists and describes the fields on this tab.

Table 8-20: Connection Monitor Counters Fields

Field Description

Node Guid Global unique ID of the IB node of the hop port.

Port Number |Port number of the hop.

Testing Connections

To test connections:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.
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A

Click the plus sign next to the Connection Counters branch. The navigation tree expands.

Click the icon (1) of the connection whose counters you want to view.
Click the Test Connection tab.
Click the Test button.

Viewing Port Counters of Connections

To view port counters:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the plus sign next to the Connection Counters branch. The navigation tree expands.

Click the plus sign next to the icon (/&) of the connection whose port counters you want to view.
The navigation tree expands.

Click the port (in GUID - port-number format) whose counters you want to view. Table 8-21 lists
and describes the fields in this display.

Table 8-21: Port Counters Fields

Field Description

Subnet Prefix Subnet prefix of the subnet on which each hop resides.

Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of
the next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Symbol Errors Total number of symbol errors detected on one or more lanes.

Link Recovery Errors Total number of times the port training state machine has

successfully completed the link error recovery process.

Link Downs Total number of times the port training state machine has
failed the link error recovery process and downed the link.

Received Errors Total number of packets containing an error that were
received on the port. These errors include:

*  Local physical errors (ICRC, VCRC, FCCRC, and all
physical errors that cause entry into the bad state)

e Malformed data packet errors (Lver, length, VL)
*  Malformed link packet errors (operand, length, VL)

»  Packets discarded due to buffer overrun

Received Remote Physical Total number of packets marked with the EBP delimiter
Errors received on the port.

Received Switch Relay Errors | Total number of packets received on the port that were
discarded because they could be forwarded by the switch
relay. Reasons for this include:

*  DLID mapping
* VL mapping

*  Looping (output port = input port)
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Field

Description

Transmit Discards

Total number of outbound packets discarded by the port
because the port is down or congested. Reasons for this
include:

*  Output port is in the inactive state.

*  Packet length exceeded neighbor MTU.
*  Switch lifetime limit exceeds.

*  Switch HOQ limit exceeds.

Transmit Constraint Errors

Total number of packets not transmitted from the port for the
following reasons:

»  FilterRawOutbound is true and packet is raw.

*  PatitionEnforcementOutbound is true and packet fails
partition key check, IP version check, or transport header
version check.

Received Constraint Errors

Total number of packets received on the port that are
discarded for the following reasons:

e FilterRawInbound is true and packet is raw.

*  PartitionEnforcementInbound is true and packet fails
partition key check, IP version check, or transport header
version check.

Local Link Integrity Errors

The number of times that the frequency of packets containing
local physical errors exceeded local phy_errors.

Excessive Buffer Overrun
Errors

The number of times that overrun errors’ consecutive flow
control update periods occurred with at least one overrun error
in each period.

VL15 Dropped

Number of incoming VL15 packets dropped due to resource
limitations on port selected by PortSelect.

Transmit Data

Optional; will be zero if not implemented. Total number of
data octets, divided by 4, transmitted on all VLs from the port
selected by PortSelect. This includes all octets between (and
not including) the start of packet delimiter and VCRC. It
excludes all link packets.

Implementers may choose to count data octets in groups
larger than four but are encouraged to choose the smallest
group possible. Results are still reported as a multiple of four
octets.

Received Data

Optional; will be zero if not implemented. Total number of
data octets, divided by 4, received on all VLs from the port
selected by PortSelect. This includes all octets between (and
not including) the start of packet delimiter and VCRC. It
excludes all link packets.

Implementers may choose to count data octets in groups
larger than four but are encouraged to choose the smallest
group possible. Results are still reported as a multiple of four
octets.

Transmit Packets

Optional; will be zero if not implemented. Total number of
data packets, excluding link packets, transmitted on all VLs
from the port selected by PortSelect.
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Table 8-21: Port Counters Fields

Field Description

Received Packets Optional; will be zero if not implemented. Total number of
data packets, excluding link packets, received on all VLs from
the port selected by PortSelect.

Viewing Port Counters

To view port counters:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the plus sign next to the Port Counters branch. The navigation tree expands.
View port counters with one of the following methods:
e Click the GUID whose port counters you want to view; all available port counters appear.

*  Click the plus sign next to the GUID of the node whose port counters you want to view, then
click the port whose counters you want to view; counters appear for that individual port.

Table 8-22 lists and describes the fields in the Port Counters display.

Table 8-22: Port Counters Fields

Field Description

Subnet Prefix Subnet prefix of the subnet on which each hop resides.

Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of
the next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Symbol Errors Total number of symbol errors detected on one or more lanes.

Link Recovery Errors Total number of times the port training state machine has

successfully completed the link error recovery process.

Link Downs Total number of times the port training state machine has
failed the link error recovery process and downed the link.

Received Errors Total number of packets containing an error that were
received on the port. These errors include:

*  Local physical errors (ICRC, VCRC, FCCRC, and all
physical errors that cause entry into the bad state)

*  Malformed data packet errors (Lver, length, VL)
*  Malformed link packet errors (operand, length, VL)

»  Packets discarded due to buffer overrun

Received Remote Physical Total number of packets marked with the EBP delimiter
Errors received on the port.
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Field

Description

Received Switch Relay Errors

Total number of packets received on the port that were
discarded because they could be forwarded by the switch
relay. Reasons for this include:

* DLID mapping
* VL mapping
*  Looping (output port = input port)

Transmit Discards

Total number of outbound packets discarded by the port
because the port is down or congested. Reasons for this
include:

e Output port is in the inactive state.

»  Packet length exceeded neighbor MTU.
e Switch lifetime limit exceeds.

e Switch HOQ limit exceeds.

Transmit Constraint Errors

Total number of packets not transmitted from the port for the
following reasons:

*  FilterRawOutbound is true and packet is raw.

»  PatitionEnforcementOutbound is true and packet fails
partition key check, IP version check, or transport header
version check.

Received Constraint Errors

Total number of packets received on the port that are
discarded for the following reasons:

*  FilterRawInbound is true and packet is raw .

*  PartitionEnforcementInbound is true and packet fails
partition key check, IP version check, or transport header
version check.

Logical Link Integrity Errors

The number of times that the frequency of packets containing
local physical errors exceeded local phy_errors.

Excessive Buffer Overrun
Errors

The number of times that overrun errors consecutive flow
control update periods occurred with at least one overrun error
in each period.

VL15 Droppeds

Number of incoming VL15 packets dropped due to resource
limitations on port selected by PortSelect.

Transmit Data

Optional; will be zero if not implemented. Total number of
data octets, divided by 4, transmitted on all VLs from the port
selected by PortSelect. This includes all octets between (and
not including) the start of packet delimiter and VCRC. It
excludes all link packets.

Implementers may choose to count data octets in groups
larger than four but are encouraged to choose the smallest
group possible. Results are still reported as a multiple of four
octets.
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Table 8-22: Port Counters Fields

Field Description

Received Data Optional; will be zero if not implemented. Total number of
data octets, divided by 4, received on all VLs from the port
selected by PortSelect. This includes all octets between (and
not including) the start of packet delimiter and VCRC. It
excludes all link packets.

Implementers may choose to count data octets in groups
larger than four but are encouraged to choose the smallest
group possible. Results are still reported as a multiple of four
octets.

Transmit Packets Optional; will be zero if not implemented. Total number of
data packets, excluding link packets, transmitted on all VLs
from the port selected by PortSelect.

Received Packets Optional; will be zero if not implemented. Total number of
data packets, excluding link packets, received on all VLs from
the port selected by PortSelect.

Viewing Cumulative Port Counters

To view cumulative port counters:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the plus sign next to the Port Counters branch. The navigation tree expands.

Click the plus sign next to the node of the port whose cumulative counters you want to view. The
navigation tree expands.

Click the port whose navigation counters you want to view.
Click the Port Cumulative Counters tab. Table 8-23 lists and describes the fields in the display.

Table 8-23: Cumulative Port Counters Fields

Field Description
Subnet Prefix Subnet prefix of the subnet on which each hop resides.
Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of

the next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Enabling Port Monitoring

To enable port monitoring:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the Port Monitor branch.
Click the General tab.




5.

6.

&9

Select Enable from the State pulldown menu.

e

NOTE: Enable will enable the port monitoring for only the ports that are configured in the
Monitor Port Config table, whereas enableAll will enable the port monitoring for all ports
regardless of whether the port is configured in the Monitor Port Config table or not.

Click the Apply button.

Configuring Port Monitoring

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the Port Monitor branch.
Click the General tab.

Enter an integer value, between 1 and 600, in the Polling Period ficld to configure the number of
seconds between polls.

Enter an integer value, between 1 and 600, in the Start Delay field to configure the delay between
startup and polling.

Configuring Port Monitoring Thresholds

To configure port monitoring thresholds:

1.

6.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

Click the Port Monitor branch.
Click the Threshold tab.

Enter an integer value in the fields where you want to apply a threshold. Enter none in the fields to
which you do not want to apply a threshold.

Click the Apply button.

Resetting Counters

You can reset counters for:

A hop.
All ports on a node.
All ports in a connection.

All ports in a subnet.

Resetting Counters on a Hop

To reset counters on a hop:

1.

Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.
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3. Click the plus sign next to the Connection Counters branch. The navigation tree expands and
connections appear.

4. Click the plus sign next to the connection that includes the hop that you want to clear. The
navigation tree expands and hops appear.

5. Right-click the hop whose counters you want to clear and select Clear counters on this Hop from
the right-click menu.

Resetting Counters on All Ports on a Node

To reset counters on a node:

1. Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

2. Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

3. Click the plus sign next to the Connection Counters branch. The navigation tree expands and
connections appear.

4. Click the plus sign next to the connection that includes the node that you want to clear. The
navigation tree expands and nodes appear.

5. Right-click the node whose counters you want to clear and select Clear counters on this Node
from the right-click menu.

Resetting Counters on All Ports in a Connection

To reset counters on all ports in a connection:

1. Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

2. Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

3. Click the plus sign next to the Connection Counters branch. The navigation tree expands and
connections appear.

4. Right-click the connection whose counters you want to clear and select Clear counters on this
Connection from the right-click menu.

Resetting all Counters in a Subnet

To reset all counters in a subnet:

1. Click the InfiniBand menu and select Performance Management. The Performance
Management window opens.

2. Click the plus sign (+) next to the subnet of the connections that you want to monitor. The
navigation tree expands.

3. Right-click the Connection Counters branch and select Clear counters for all Connections.

Launching Topology View

To launch the Topology view:

1. Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

2. (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.
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3. Click the OK button. The InfiniBand Topology window appears. Navigation buttons appear at the
top of the InfiniBand Topology window. Table 8-24 lists and describes these buttons.

Table 8-24: InfiniBand Topology Navigation Buttons

Button® Description

Refresh Refreshes the topology display.

Layout Evenly arranges the switch and HCA icons.

Zoom In Enlarges the display.

Zoom Out Condenses the display.

Fit to Screen Zooms in or out to fit the topology in the window.
B

L

Specify Topspin Devices
=3
==

Opens the Specify Topspin Devices dialog box to add switches to the
display.

(2

Legend Displays the different colors that represent different types of links.
Subnet Details Displays subnet details. For more information, refer to “Viewing Subnet
Details Details” on page 92.

Help Launches on-line help.

Viewing Internal Server Switch Components

To view the switches and target Channel Adapters (TCAs) inside a server switch:

1. Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box

opens.

2. (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

3. Click the OK button. The InfiniBand Topology window appears.
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4. Double-click a server switch icon. The Internal InfiniBand Topology window opens. Navigation
buttons appear at the top of the Internal InfiniBand Topology window. Table 8-25 lists and
describes these buttons.

Table 8-25: Internal InfiniBand Topology Navigation Buttons

Button Description

Layout Evenly arranges the switch and HCA icons.
Zoom In Enlarges the display.

Zoom Out Condenses the display.

Fit to Screen Zooms in or out to fit the topology in the window.
Q

L

Layout Evenly arranges the switch and HCA icons.
Subnet Management Agents |Displays SM agent details. For information, refer to “Viewing Subnet
Shids Management Agents” on page 95.

Help Launches on-line help.

Viewing Subnet Details

You can view any of the following subnet details:
* nodes

*  ports

*  switches

* neighbors

Viewing Nodes

To view the nodes in the Topology view:

1. Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

2. (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.
4. Click the Details button. The InfiniBand Subnet Details window opens.
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5. Click the Nodes tab. Table 8-26 lists and describes the fields on this tab.
Table 8-26: Nodes Tab Fields

Field Description

SubnetPrefix The subnet prefix of the node.

GUID The global unique ID (GUID) of the node.

Description An optional text string describing this node.

Type Type of node being managed.

NumPorts Number of physical ports on this node.

SystemImageGUID |The system image GUID of this node. All nodes within a particular system
(chassis) are assigned the same system image GUID.

Viewing Ports

To view the ports in the Topology view:

1. Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

2. (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.
4. Click the Details button. The InfiniBand Subnet Details window opens.
Click the Ports tab. Table 8-27 lists and describes the fields on this tab.

Table 8-27: Ports Tab Fields

Field Description
SubnetPrefix The subnet prefix of the node.
NodeGUID The global unique ID (GUID) of the node that includes the port.
Port Local port number for this port.
LID 16-bit base LID of this port.
State State of the port:
* noStateChange
* sleep
* polling
» disabled

» portConfigurationTraining
e linkup

* linkErrorRecovery

» reserved

* active

 down
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Table 8-27: Ports Tab Fields (Continued)

Field (Continued)

Description

LinkWidthActive

Currently active link width, indicated as follows:

. I: 1x
e 2:4x
e 8:12x

e 0,3,4-7,9-255 reserved

Viewing Switches

To view the switches in the Topology view:

1.

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box

opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.
Click the Details button. The InfiniBand Subnet Details window opens.
Click the Switches tab. Table 8-28 lists and describes the fields on this tab.

Table 8-28: Switches Tab Fields

Field Description

SubnetPrefix The subnet prefix of the node.

NodeGUID The global unique ID (GUID) of the node that includes the switch.

LinearFdbCap Number of entries supported in the Linear Unicast Forwarding table. Zero
indicates that there is no Linear Forwarding Database.

RandomFdbCap Number of entries supported in the Random Unicast Forwarding table. Zero
indicates that there is no Random Forwarding Database.

McastFdbCap Number of entries supported in the Multicast Forwarding table.

LinearFdbTop Indicates the top of the Linear Forwarding Table. Packets received with
unicast DLIDs greater than this value are discarded by the switch. This
component applies only to switches that implement Linear Forwarding
Tables and is ignored by switches that implement Random Forwarding
Tables.

DefaultPort Forward to this port all the unicast packets from the other ports whose
DLID does not exist in the Random Forwarding Table.

DefPriMcastPort  |Forward to this port all the multicast packets from the other ports whose
DLID does not exist in the forwarding table.

DefNonPriMcastPo |Forward to this port all the multicast packets from the smDefPriMcastPort

rt port whose DLID does not exist in the forwarding table.

LifeTimeValue The time a packet can live in the switch.

PortStateChange |Identifies whether or not the port is in transition.

LIDPerPort Number of LID/LMC combinations that may be assigned to a given
external port for switches that support the random forwarding table.

PartitionEnfCap The number of entries in this partition enforcement table per physical port.
Zero indicates that partition enforcement is not supported by the switch.

InEnfCap Indicates switch is capable of partition enforcement on received packets.
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Table 8-28: Switches Tab Fields (Continued)

Field

Description

OutEnfCap

Indicates switch is capable of partition enforcement on transmitted packets.

InFilterRawPktCap

Indicates switch is capable of raw packet enforcement on received packets.

OutFilterRawPktC
ap

Indicates switch is capable of raw packet enforcement on transmitted
packets.

Viewing Neighbors

To view the ports in the Topology view:

1.
opens.

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want

to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Click the Details button. The InfiniBand Subnet Details window opens.

Click the Neighbors tab. Table 8-29 lists and describes the fields on this tab.

Table 8-29: Neighbors Tab Fields

Field

Description

SubnetPrefix

Used to identify IB subnet in which this IB node is located.

LocalNodeGuid

The global unique ID (GUID) of the IB node.

LocalPortld

Identifies the port IDof the IB node.

LocalNodeType

Identifies the IB node's node-type.
» channelAdapter

e switch

RemoteNodeGuid

The global unique ID (GUID) of the remote IB node.

RemotePortld

Identifies the port id of the remote IB node.

RemoteNodeType

Identifies the remote IB node's node-type.
» channelAdapter

e switch

LinkState

Used to identify the state of the link connecting the neighbors.
* noStateChange

* down

* initialize

e active

LinkWidthActive

Used to identify the width of the link connecting the neighbors.

Viewing Subnet Management Agents

You can view any of the following SMA details:

¢« Nodes
e Switches

*  Switch Cap
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Ports (1)
Ports (2)
Mcast

Linear Forwarding

PKey
SLVL Map

Nodes

To view SMA node details:

1.

AR

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box

opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Click the SMAs button. The Subnet Manager Agents window opens.
Click the Nodes tab. Table 8-30 lists and describes the fields on this tab.

Table 8-30: Nodes Tab Fields

Field Description

Guid Subnet prefix of this IB subnet.

BaseVersion Supported base management datagram version.

ClassVersion |Supported subnet management class.

Type Type of node being managed:
*  channelAdapter
e switch

PortGuid GUID of this port. One port within a node can return the nodeGUID as its
PortGUID if the port is an integral part of the node and is not field-replaceable.

PartitionCap |Number of entries in the partition table for channel adapter, router, and the
switch management port. This is, at a minimum, set to 1 for all nodes including
switch.

Deviceld Device ID information as assigned by device manufacturer.

Revision Device revision, assigned by manufacturer.

LocalPortNum |The link port number this SNMP packet came in on.

Vendorld Device vendor ID, per IEEE.

TrapBuffer Special purpose string buffer for IB Trap Data.

String Description of the node.

NumPorts Number of physical ports on this node.




97

Switches

To view SMA switch details:

1.

AN

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.
Click the SMAs button. The Subnet Manager Agents window opens.

Click the Switches tab. Table 8-31 lists and describes the fields on this tab.

Table 8-31: Switches Tab Fields

Field Description
Guid Global unique ID of the switch.
LftTop Indicates the top of the Linear Forwarding Table. Packets received with

unicast DLIDs greater than this value are discarded by the switch. This
component applies only to switches that implement Linear Forwarding
Tables and is ignored by switches that implement Random Forwarding
Tables.

DefaultPort Forward to this port all the unicast packets from the other ports whose
DLID does not exist in the Random Forwarding Table.

DefMcastPriPort |Forward to this port all the multicast packets from the other ports whose
DLID does not exist in the forwarding table.

DefMcastNPPort |Forward to this port all the multicast packets from the Default Primary port
whose DLID does not exist in the forwarding table.

LifeTimeValue Time a packet can live in the switch.

PortStateChange  |It is set to one anytime the PortState component in the PortInfo of any ports
transitions from Down to Initialize, Initialize to Down, Armed to Down, or
Active to Down as a result of link state machine logic. Changes in Portstate
resulting from SubnSet do no change this bit. This bit is cleared by writing
one, writing zero is ignored.

LidsPerPort Specifies the number of LID/LMC combinations that may be assigned to a
given external port for switches that support the Random Forwarding Table.

Switch Cap

To view SMA switch cap details:

1.

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.
Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Click the SMAs button. The Subnet Manager Agents window opens.
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6.

Click the Switch Cap. tab. Table 8-32 lists and describes the fields on this tab.
Table 8-32: Switch Cap Tab Fields

Field Description

LftCap Number of entries supported in the Linear Unicast Forwarding Table.

RftCap Number of entries supported in the Random Unicast Forwarding Table.
RandomFDBCap = 0 indicates that there is no Random Forwarding
Database.

MftCap Number of entries supported in the Multicast Forwarding Table.

PartitionEnfCap Specifies the number of entries in the partition enforcement table per
physical port. Zero indicates that partition enforcement is not supported by
the switch.

InboundEnfCap Indicates switch is capable of partition enforcement on received packets.

OutboundEnfCap |Indicates switch is capable of partition enforcement on transmitted packets.

FilterRawPktInCap | Indicates switch is capable of raw packet enforcement on received packets.

FilterRawPktOutC |Indicates switch is capable of raw enforcement on transmitted packets.
ap

Ports (1)

To view SMA port details:

1.

S kW

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.
Click the SMAs button. The Subnet Manager Agents window opens.

Click the Ports (1) tab. Table 8-33 lists and describes the fields on this tab.

Table 8-33: Ports (1) Tab Fields

Field Description

NodeGuid 64-bit GUID of the node that contains this port.

IbPort The local port number of this port (relative to a particular node).
MKey 64-bit management Key for this port.

GidPrefix 64-bit global ID prefix for this port.

Lid 16-bit base LID of this port.

MasterSMLid 16-bit base LID of the master SM that is managing this port.
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Field Description
CapabilityMask Supported capabilities of this node:
* 0: Reserved, will be zero
«  1:IsSM
*  2:IsNoticeSupported
*  3:IsTrapSupported
e 4:IsResetSupported
e 5: IsAutomaticMigrationSupported
*  6: IsSLMappingSupported
e 7:IsMKeyNVRAM
» 8:IsPKeyNVRAM
*  9: IsSLEDInfoSupported
e 10: IsSMDisabled
¢ 11-15: Reserved, will be zero
* 16: IsConnectionManagerSupported
e 17: IsSSNMPTunnelingSupported
¢ 18: Reserved, will be zero
* 19: IsDeviceManagementSupported
*  20: IsVendorClassSupported
e 21-31: Reserved, will be zero
DiagCode Port diagnostic code.
MKeyLeasePeriod |Timer value used to indicate how long the M_Key protection bits are to
remain non-zero after a SubnSet (PortInfo) fails an M_Key check. The
value of the timer indicates the number of seconds for the lease period.
LocalPortNum Local port number.
LinkWidthEnabled |Enabled link width (1x, 4x, or 12x).
LinkWidthSupport |Supported link width.
ed
LinkWidthActive |Currently active link width.
LinkSpeedSupporte | Supported link speed (in Gbps).
d
State State of the port:

¢ noStateChange
* down

* initialize

* armed

e active
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Table 8-33: Ports (1) Tab Fields (Continued)

Field Description
PortPhys State of the physical port:
* noStateChange(0),
e sleep
* polling
» disabled

¢ portConfigurationTraining
e linkup
* linkErrorRecovery

e reserved

MKeyProtectBits | Determines MADheader behavior.

LMC LID mask for multipath support.

LSActive Current active link speed.

LSActiveEnabled |Enabled link speed.

NeighborMTU Active maximum MTU enabled on this port for transmit.

MasterSMSL The administrative SL of the master SM that is managing this port.

Ports (2)

To view extended SMA port details:

1. Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

2. (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.
Click the SMAs button. The Subnet Manager Agents window opens.

Click the Ports (2) tab. Table 8-34 lists and describes the fields on this tab.

S kW

Table 8-34: Ports (2) Tab Fields

Field Description

NodeGuid 64-bit GUID of the node that contains this port.

IbPort The local port number of this port (relative to a particular node).

VLCap Virtual lanes supported on this port.

VLHighLimit Limit of high priority component of VL arbitration table.

VLArbitrationHighC |VL/Weight pairs supported on this port in the smVLArbTable for high

ap priority.

VLArbitrationLowCa | VL/Weight pairs supported on this port in the smVLArbTable for low

p priority.

MTUCap Maximum MTU supported by this port.

VLStallCount Specifies the number of sequential packets dropped that causes the port to
enter the VLStalled state.

HOQLife Time a packet can live at the head of a VL queue.
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Table 8-34: Ports (2) Tab Fields (Continued)

Field Description

OpVLs Virtual Lanes operational on this port.

PkeyEnfIn Indicates support of optional partition enforcement on packets received
from this port.

PkeyEnfOut Indicates support of optional partition enforcement on packets
transmitted from this port.

FilterRawPktIn Indicates support of optional raw packet enforcement on raw packets
received from this port.

FilterRawPktOut Indicates support of optional raw packet enforcement on raw packets
transmitted from this port.

MKeyViolations Number of SMP packets that have been received on the port that have
had invalid M_Key since poweron or reset.

PKeyViolations Number of packets that have been received on the port that have had
invalid P_Key since poweron or reset.

QKeyViolations Number of packets that have been received on the port that have had
invalid Q Key since poweron or reset.

GuidCap Number of GUID entries supported in the GUIDInfo attribute for this
port.

SubnetTimeout Maximum expected subnet propagation delay.

RespTimeValue Expected maximum time between the port reception of an SMP and the
transmission of the associated response.

LocalPhysErr Threshold value. When the count of marginal link errors exceeds this
threshold, the local link integrity error is detected.

OverrunErr Overrun threshold value. When the count of buffer overruns exceeds the
threshold, an excessive buffer overrun error occurs.

Mcast

To view SMA multicast details:

1.

AR

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box

opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Click the SMAs button. The Subnet Manager Agents window opens.
Click the Mcast tab. Table 8-35 lists and describes the fields on this tab.

Table 8-35: Mcast Tab Fields

Field Description

NodeGuid GUID of the node.

TableBlockIndex |Index into the multicast block table; this index starts from 1 rather than 0.
TableBlock List of 32 PortMask Block Elements. 16 bits starting at position 16*p of the

port mask associated with the particular LID. An incoming packet with this
LID is forwarded to all ports for which the bit in the port mask is set to 1.
Note that an invalid LID is indicated with an all zero PortMask.
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Linear Forwarding

To view SMA Linear Forwarding Table details:

1.

AN

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.
Click the SMAs button. The Subnet Manager Agents window opens.

Click the Linear Forwarding tab. Table 8-36 lists and describes the fields on this tab.

Table 8-36: Linear Forwarding Tab Fields

Field Description
NodeGuid |GUID of the node.

BlockIndex |Index into the Linear Forwarding Table; this index starts from 1 rather than 0.

Block Linear Forwarding Table block.

PKey

To view SMA partition details:

1.

AN

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.
Click the SMAs button. The Subnet Manager Agents window opens.

Click the PKey tab. Table 8-37 lists and describes the fields on this tab.

Table 8-37: PKey Tab Fields

Field Description

NodeGuid |GUID of the node.

IbPort Port number.

Index PKEY table index.

TableVecto |GUID assigned by the SM on the subnet.
r

SLVL Map

To view SMA SLVL details:

1.

Click the InfiniBand menu and select Topology View. The Specify Topspin Devices dialog box
opens.

(Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want
to add to the Topology View display.

Click the OK button. The InfiniBand Topology window appears.

Double-click a server switch icon. The Internal InfiniBand Topology window opens.
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Click the SMAs button. The Subnet Manager Agents window opens.
6. Click the SLVL Map tab. Table 8-38 lists and describes the fields on this tab.

Table 8-38: SLVL Map Tab Fields

Field Description
NodeGuid |GUID of the node.

InlbPort |Ingress port number.

OutlbPort |Egress port number.
Sl#toVI SL# to VL mapping.

Viewing Device Management
/O

NOTE: Device Management (DM) features are only available on I/O chassis (Topspin 90/Cisco SFS
3001, Topspin 360/Cisco SFS 3012).

With Device Management, you can:
e View IOUs.
e View IOCs.

e View IOC Services.

Viewing IOUs

To view the I/O Units (IOUs) on your device:
1. Click the InfiniBand menu and select DM. The Device Manager window opens.
2. Click the IOU tab. Table 8-39 lists and describes the fields on this tab.

Table 8-39: 10U Display Fields

Field Description
Change ID Cumulative number of changes to the controller list since the device last
booted.

Max Controllers Maximum number of controllers that your device can support.

Diag Device ID All device IDs appear as 1.

Option ROM Indicates the presence or absence of Option ROM.

Controllers Lists each slot on your device that can potentially contain a controller and
identifies whether or not a controller resides in that slot.
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Viewing IOCs

To view the I/O controllers (IOCs) on your device:

1.
2.

Click the InfiniBand menu and select DM. The Device Manager window opens.
Click the IOC tab. Table 8-40 lists and describes the fields on this tab.

Table 8-40: I0Cs Display Fields

Field Description

GUID GUID of the controller.

Vendor ID Organization Unique Identifier (OUI) of the vendor.
Device ID Vendor-assigned device identifier.

Device Version

Vendor-assigned device version.

Subsystem Vendor ID Vendor-assigned subsystem vendor identifier.
Subsystem ID Vendor-assigned subsystem identifier.

I0Class I/O class that the IOC supports.

IOSubclass Subclass of the I/O class protocol of the IOC.
Protocol Standard protocol definition that the IOC supports.

Protocol Version

Protocol version that the IOC supports.

Send Msg Queue Depth | Maximum number of messages that the send message queue
supports.

RDMA Read Queue Maximum depth of the per-channel RDMA Read Queue.

Depth

Send Msg Size Maximum size, in bytes, of send messages.

RDMA transfer size Maximum size, in bytes, of outbound RDMA transfers that the IOC

initiates.

Controller Op Cap

Integer value (from 8 cumulative bits) between 1 and 255 that
represents the operation type(s) that the IOC supports:

*  bit 0: ST—Send Messages To I0Cs

*  bit 1: SF—Send Messages From 10Cs

e bit 2: RT—RDMA Read Requests To IOCs

*  bit 3: RF—RDMA Read Requests From I0Cs
*  bit4: WT—RDMA Write Requests To IOCs

*  bit 5: WF—RDMA Write Requests From IOCs
*  bit 6: AT—Atomic Operations To I0Cs

*  bit 7: AF—Atomic Operations From IOCs

Service Entries

Number of services that the IOC provides.
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Viewing IOC Services

To view the IOC services on your device:

1.
2.

Click the InfiniBand menu and select DM. The Device Manager window opens.

Click the IOC Services tab. A table of IOC Services details appears. Table 8-41 lists and describes
the fields in this table.

Table 8-41: I0C Services Table Fields

Field Description
10C GUID GUID of the node that provides the service.
Service Name ASCII identifier of the service.

Service ID Numeric identifier that nodes use to call the service.




106



107

Help Menu Tasks

The following sections appear in this chapter:

*  “Introduction” on page 107

*  “Launching On-Line Help” on page 107

¢ “Launching the Support Web Site”” on page 107

*  “Viewing the Element Manager Status Legend” on page 108

Introduction

The tasks under the Help menu provide EM resources and Support resources. For context-sensitive
on-line help, click the Help button in any EM window.

Launching On-Line Help

To launch on-line help, click the Help menu and select Contents.

Launching the Support Web Site

To launch the support Web site, click the Help menu and select Online Support.
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Viewing the Element Manager Status Legend

To view the EM status legend, click the Help menu and select Legend.

Example

Zonkents F1
Cnline Support \_
BT =
Abauk?, W Dovin

| Mo Link,
Unmanaged
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